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About this Guide

This guide describes how to install and upgrade the GigaVUE—FM® Fabric Manager
(GigaVUE-FM).

Installation

« Install GigaVUE-FM on VMware ESXi

» Install GigaVUE-FM on AWS

» Install GigaVUE-FM on Azure

« Install GigaVUE-FM on OpenStack

= Install GigaVUE-FM on Nutanix

« Install GigaVUE-FM Instance for Kubernetes
« Install GigaVUE-FM on MS Hyper-V

« Install GigaVUE-FM on KVM

Upgrade
» Important GigaVUE-FM Upgrade Guidance
= Upgrade GigaVUE-FM
«» Upgrade GigaVUE-FM in Azure
«» Upgrade GigaVUE-FM in AWS

Reference

» GigaVUE-FM CLI Commands
« Setting the GigaVUE-FM Admin Password

About this Guide
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Install GigaVUE-FM on VMware
ESXI

This section describes how to install GigaVUE-FM on VMware hypervisor, ESXI. It consists of
the following main sections:

« Before You Install describes the minimum hardware and computing requirements.

« Install New GigaVUE-FM on VMware ESXi describes the steps to install and deploy
GigaVUE-FM on VMware ESXi hypervisor.

Before You Install

This section describes the hardware and virtual computing requirements for GigaVUE-FM.
Ensure that the time on the VMware ESXi host is set correctly to ensure accuracy of the
trending data that is captured.

Prerequisites for GigaVUE-FM

Before Installing GigaVUE-FM, ensure that VMware vSphere Standard, Enterprise, or
Enterprise Plus is installed on hardware that meets minimum requirements. The following
VMware vSphere versions are supported. Note the minimum version requirements under
Hardware Requirements.

VMware ESXi and NSX-V Hardware Requirements

The following table describes the hardware requirements on which VMware ESXi runs
GigaVUE-FM.

Table 1: Hardware Requirements for VMware Hypervisor

Hardware Requirements

VMware Hypervisor | vSphere ESXi: v5.5 and above.

CPU One or more 64-bit x86 CPUs with virtualization
assist (Intel-VT or AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for
virtualization must be enabled on the VMware
ESXi host. Make sure that the BIOS option for
virtualization support is not disabled. For more
information, see your BIOS documentation

Install GigaVUE-FM on VMware ESXi
Before You Install
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Hardware Requirements

RAM At least 8GB

Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or
locally attached storage (PATA, SATA, SCSI)

NOTE: Increase the disk space depending on the
configuration load requirements for the given
GigaVUE-FM instance.

Network At least one 1Gb NIC

The following table lists the virtual computing resources for GigaVUE-FM.

Table 2: Minimum Virtual Computing Requirements for VMware Hypervisor

Minimum Virtual Computing Requirements

Memory Minimum 16GB memory
Virtual CPU (VvCPU) 2 vCPU
Virtual Storage for Guest 84GB using PVSCSI (VMware Paravirtual SCSI)

e System Disk - 40GB
e Swap Disk - 4GB
e Data Disk - 40GB

Virtual Network Interfaces One VNIC using VMXNET3 (VMware 3rd Generation Paravirtual
NIC)

Supported Browsers

GigaVUE-FM has been tested on the following browsers:

Browser Version

Mozilla Firefox™ « Version 49.00

Apple® safari® « Version 9.1 and Higher
Google®Chrome® « Version 54 and higher
Microsoft Edge = \Version 38

Notes:

e Only the browsers that support TLS v1.2 can access GigaVUE-FM.

e Internet Explorer 11 (IE11) is deprecated for security reasons and is no longer supported. |E
users are strongly encouraged to switch to Microsoft Edge.

Install GigaVUE-FM on VMware ESXi
Before You Install
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Install New GigaVUE-FM on VMware ESXi

The GigaVUE-FM software package is distributed as an OVA file. The following sections
describe how to deploy a fresh installation of GigaVUE-FM on an ESXi host and perform its
initial configuration:

« Deploy GigaVUE-FM from an OVA File

« Initial GigaVUE-FM Configuration

Deploy GigaVUE-FM from an OVA File

Use the vSphere Client to install the GigaVUE-FM OVA file. Starting from software version 5.3,
you cannot deploy GigaVUE-FM directly from the ESXi host. You must login to the VCenter
on the vSphere client to deploy a GigaVUE-FM instance.

NoTE: The OVA file must be stored in a location that is accessible to the vSphere
Client. This location cannot be a datastore accessible to the ESXi host which will be
the target of the deployment.

NOTE: Starting in software version 5.4.01, you cannot deploy the GigaVUE-FM OVA file
on older versions of VMware ESXi. If you have an older version of ESXi, then you must
upgrade your VMware ESXi to at least version 5.5. Otherwise, GigaVUE-FM OVA
deployment will fail.

The following steps are shown using the ESXi version 6.x. To deploy a GigaVUE-FM instance:

1. Log in to the VMware vCenter web interface.
2. Goto Menu > VMs and Templates.

3. Right-click the ESXi Host or data center on which you want to deploy GigaVUE-FM 5,16,
and then select Deploy OVF Template.

NoTE: GigaVUE-FM v5.8 is used for illustration purposes only throughout this
example. In your deployment, you will select the version that you are deploying.

Install GigaVUE-FM on VMware ESXi 10
Install New GigaVUE-FM on VMware ESXi
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vm v5Sphere Client

8 9 [h TME-D

el

v 7 10.115.154.1
~ [ TME-PrA-KMSYT
~ £ Dis [ER Actions - TME-DC4-NSXT

31 ¥] Add Host_

ﬂ y

summary M

?@ Mew Cluster__.
Mew Folder
Distributed Switch

Eﬂ Mew Virtual Machine.

Y Deploy OVF Template. .

Storage

Edit Default WM Compatibility...

Figure1 vSphere Client: OVF Template
The Deploy OVF Template wizard opens.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

1 Select an OVF template

2 Select a name and folder
3 Select a compute resource
4 Review details

5 Select storage

6 Ready to complete

Select an OVF template
Select an OVF template from remote URL or local file system

Enter a URL to download and install the OVF package from the Internet, or browse to a
location accessible from your computer, such as a local hard drive, a network share, or a
CD/DVD drive.

® URL

hitp | hitps:/remoteserver-address/filetodeploy.ovf | .ova

O Local file

Browse...

CANCEL

Figure 2 vSphere Client: Find the Location of the OVA File

4. In the Select an OVF template page of the Deploy OVF Template wizard, choose one

of the following options:

a. URL—Enter the URL from where you want to download and install the OVF

package.

b. Local file—Click Browse to navigate to the OVA file available on your local machine,
and then select the OVAfile.

5. Click the Next. The Select a name and folder page of the Deploy OVF Template

wizard appears.

NoOTE: This example uses GigaVUE-FM v5.8 for illustration purposes only. In your
instance, you will see the version you are deploying.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

+ 1 Select an OVF template Select a name and folder

_ Specify a unique name and target location

3 Select a compute resource

4 Review details Virtual machine name: gigamon-gigavue-fm-5.8.00-

5 Select storage

6 Ready to complete Select a location for the virtual machine.

v 31101151541
> [E§ TME-DC4-NSXT

CANCEL BACK NEXT

Figure 3 vSphere Client: Enter Name and Location for OVA File on ESXi Server
6. Specify a unigue name for the GigaVUE-FM instance, and then select a location and
host to which you want to deploy the GigaVUE-FM instance.

7. Click Next. The Select a compute resource page of the Deploy OVF Template wizard
appears.

Install GigaVUE-FM on VMware ESXi 13
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Deploy OVF Template

+ 1 Select an OVF template Select a compute resource

+ 2 Select a name and folder Select the destination compute resource for this aperation
4 Review details W Cloud-LAB
5 Select storage > Cloud-1
6 Ready to complete b Cloud-2

» Cloud-3

Compatibility

+" Compatibility checks succeeded.

CANCEL BACK NEXT

Figure 4 vSphere Client: Select a Compute Resource for the OVF Deployment

8. Select a destination compute host for the OVF deployment. The Deploy OVF Template
wizard performs a validation to ensure that the selected host has all the resources
required for the GigaVUE-FM deployment.

9. Click Next. The Review details page of the Deploy OVF Template wizard appears.

NOTE: This example uses GigaVUE-FM v5.8 for illustration purposes only. In your
instance, you will see the version you are deploying.

Install GigaVUE-FM on VMware ESXi 14
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Deploy OVF Template

+ 1 Select an OVF template Review details

+ 2 Select a name and folder Verify the template details.

+ 3 Select a compute resource

4 Review details

5 Select storage Publisher

6 Select networks N

7 Customize template

8 Ready to complete Version
Vendor

Description

Download size

Size on disk

Mo certificate present

GigaVUE-FM

5.8.00

Gigamon Inc.

This is a Gigamon GigaVUE-FM Appliance. It provides a centralized view
across both physical and virtual Traffic Visibility Fabric Nodes.

41GB

6.1 GB (thin provisioned)

84.0 GB (thick provisioned)

CANCEL BACK NEXT

Figure 5 vSphere Client: Review Details

10. Verify the OVF template details, and then click Next. The Select storage page of the
Deploy OVF Template wizard appears.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

+ 1 Select an OVF template Select storage

+ 2 Select a name and folder Select the storage for the configuration and disk files

+ 3 Select a compute resource

+ 4 Review details ]

5 Select storage

6 Select networks

Select virtual disk format: ~ Thick Provision

7 Customize template WM Storage Policy: Datastore Default e
8 Ready to complete MName Capacity Provisioned Free TVE
EET. 924 GB 15913 GB 84112 GB Vi
j 924 GB 710.94 GB 460.91 GB Vi
< 3
Compatibility
+" Compatibility checks succeeded.
CANCEL

BACK NEXT

Figure 6 vSphere Client: Select Storage

1. From the Select virtual disk format drop-down list, select Thick Provisioning as the

format for the virtual disks and provisioning.

choice results in GigaVUE-FM not working correctly.

NoOTE: You must deploy GigaVUE-FM using Thick Provisioning. Any other

12. Select the datastore where the virtual machine’s files will be stored.
13. Click Next. The Select networks page of the Deploy OVF Template wizard appears.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

+ 1 5Select an OVF template Select networks

+ 2 Select a name and folder Select a destination network for each source network.

" 3 Select a compute resource
+ 4 Review details Source Metwork T Destination Network T

+ 5 Select storage management WM Network w

6 Select networks 1items

7 Customize template

8 Ready to complete

IP Allocation Settings

IP allocation: Static - Manual

IP protocol: IPva

CANCEL BACK NEXT

Figure 7 vSphere Client: Select Networks

14. Set network mapping by doing either of the following, depending on how your are
deploying, and then click Next:

o If you are not deploying on a standalone ESXi host, the Network Mapping
displays under Source Networks. Use the drop-down lists to assign the correct
Destination Network to the source network.

o If you are deploying GigaVUE-FM on a standalone ESXi host, the network
mapping is set automatically by assigning the destination network to the
VM Network. In case of multiple port groups, you need to manually assign the
destination network to the VM Network.

Install GigaVUE-FM on VMware ESXi 17
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15. Click Next. The Customize template page of the Deploy OVF Template wizard
appears.

16. In the System Hostname field, enter the hostname of the GigaVUE-FM instance, and
then specify 40 GB as the size of the data disk.

17. Set the admin password. The admin password must be a minimum of 11 characters
and a maximum of 30 characters. The characters must include at least:

o

o

(e]

One numerical character

One upper case character
One lower case character
One special character

NoOTE: The password that you set here is applicable only to the GigaVUE-FM
Shell. To access the GigaVUE-FM Ul, the default username is admin and
password is admin123All. You can change the password when you first login to
the GigaVUE-FM UL.

If the password does not meet the complexity requirements:

o

(e]

The system does not display any error message.
The parameters configured above are not passed on to the GigaVUE-FM except the
host name parameter.

The static IP addresses that were configured originally will be unavailable after
GigaVUE-FM is deployed.

18. (Optional) Complete the IP Networking configurations such as the default gateway for
the management port, IP address of the DNS server, and the domain name for this
GigaVUE-FM instance.

19. (Optional) Complete the NTP configurations such as the IP address and version of the
NTP server, and then click Next.

Install GigaVUE-FM on VMware ESXi 18
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v 3 Select a compute resource

+ 4 Review details

| All properties have valid values

+ 5 Select storage
+ 6 Select networks

7 Customize template

8 Ready to complete

« Basic Configuration

01. System Hostname

02. Size of Data Disk

03. Optional admin

password

4 settings

A Unigue hostname for this instance.

GigaVUE-FM-5800

The size of the Data Disk in gigabytes.

a0 =

If set, the default admin password will be set to
this value to allow password based login. The
password will be good for only a single login. You
MUST specifiy either a password or an S5H Public
Key, otherwise you will NOT be able to access

your GigaVUE-FM instance.
Password

Confirm

Password

Deploy OVF Template
”~
+ 1 5Select an OVF template Customize template
v 2 Select a name and folder Customize the deployment properties of this software solution.

L

CANCEL BACK NEXT

Figure 8 vSphere Client: Customize Template

NOTE: You can also choose to perform the IP Networking and NTP
configurations by running the fmectl jump-start coommand after you power on
the GigaVUE-FM instance at the successful completion of the OVF template
deployment. For details, refer to Perform Network Configurations

The Ready to Complete page of the Deploy OVF Template wizard appears.

NoOTE: This example uses GigaVUE-FM v5.8 for illustration purposes only. In your
instance, you will see the version you are deploying.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Deploy OVF Template

1 Select an OVF template Ready to complete

2 Select a name and folder

Click Finish to start creation.

3 Select a compute resource

5 Select storage Provisioning type

v

v

v

+ 4 Review details
v

+ 6 Select networks Name
v

7 Customize template

8 Ready to complete

Template name

Download size

Size on disk

Folder

Resource

Storage mapping
All disks

MNetwork mapping
management

IP allocation settings
IP protocol

IP allocation

Deploy OVF From Remote URL
gigamon-gigavue-fm-5.8.00
gigamon-gigavue-fm-5.8.00

41GB

E1GE

Workload

Cloud-2

1

Datastore: 10.210.108.7; Format: Thick Provision
]

WM Network

IPV4

Static - Manual
W

CANCEL BACK FINISH

Figure 9 vSphere Client: Final Verification Before Installation

20. Verify that all of the settings are correct, and then click Finish. The Recent Tasks pane
of the vSphere Client Home page shows the progress of the deployment operation.

Recent Tasks Alarms

Task Mame ~ Target ~ Status

Deploy OVF template gigamon-gigavue-im_. [l
Import OVF package Cloud-2 [ ]

4 Details
5% &
7% 9

Figure 10 vSphere Client: OVF Deployment Progress

When the operation completes, you have successfully deployed a GigaVUE-FM

instance.

Important: Clear the browser cache before logging in to GigaVUE-FM.

Install GigaVUE-FM on VMware ESXi
Install New GigaVUE-FM on VMware ESXi
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Redeploy GigaVUE-FM Instance (with VMs Already
Deployed)

If there is a need to remove an existing instance of GigaVUE-FM and reinstall it, delete all the
virtual centers configured in the Virtual > Management > Virtual Center tab prior to deleting
the GigaVUE-FM. To re-install GigaVUE-FM, refer to the Install New GigaVUE-FM on VMware
ESXi or Install GigaVUE-FM for Microsoft Hyper-V.

By deleting the virtual centers, you will lose all the GigaVUE-VM nodes and vMaps
configured on those virtual centers and they will need to be recreated.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you can choose to perform some
initial configuration before you start using GigaVUE-FM. This procedure only needs to be
performed once for each GigaVUE-FM instance deployed.

NOTE: Use care when Shutting Down or Rebooting a GigaVUE-FM. Never directly
Power-Off the virtual machine. In VMware ESXi environment when using vSphere
client, ALWAYS use Shut Down Guest OS or Restart Guest functions from VMware.
Access is available from either the FILE menu or from the appropriate buttons on the
GigaVUE-FM console. Failure to follow these steps may lead to database corruption
issues.

Use Fault Tolerance for GigaVUE-FM Deployments (VMware ESXi
only)

Gigamon recommends that you enable the VMware Fault Tolerance feature for the
GigaVUE-FM virtual machine, providing redundancy in the case of a failure. Enabling the
VMware Fault Tolerance feature provides a “hot” GigaVUE-FM virtual machine instance on
another ESXi host in the cluster. If the ESXi host with the primary GigaVUE-FM instance goes
down, you can take advantage of the Fault Tolerance feature to continue GigaVUE-FM
operations.

When in Fault Tolerance mode, the MAC address and the UUID for both the primary
GigaVUE-FM and the “hot” GigaVUE-FM virtual machine instance remains the same,
therefore there is no need to update the existing licenses for GigaVUE-FM or GigaVUE-VM
that are installed on the primary.

Install GigaVUE-FM on VMware ESXi 21
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Both instances of the GigaVUE-FM implement VMware vLockstep technology to keep in
virtual lockstep with each other. Any events are executed on the primary and then
transmitted over a Gigabit Ethernet network to the other instance. Both instances access a
common disk and appear as a single instance since they share the MAC address and UUID.

NoTE: Refer to the VMware Fault Tolerance documentation for deployment
requirements and instructions.

Depending on the host configurations, there may be a need to shutdown GigaVUE-FM
(primary) to enable the Fault Tolerance mode.

Perform Initial Configuration

Before powering on GigaVUE-FM, you can optionally perform the following:

« Perform Network Configurations
« Add Additional vNIC

« Increase the Memory

« AddvCPUs

Perform Network Configurations

To perform the initial configuration:
1. Log in to GigaVUE-FM using one of the following methods:

o Ifyou have a static IP address set up for the GigaVUE-FM, log in through SSH.

o Ifyou do not have a static IP address set up for the GigaVUE-FM, complete the
following steps:

Log in to the VMware vCenter web interface.
b. Goto Menu > VMs and Templates.

c. Right-click the GigaVUE-FM virtual machine, and select Open Remote
Console.

d. Log in with your GigaVUE-FM Shell credentials.

2. Perform the following steps to complete the initial configuration:

a. Run the fmctl jump-start command. The Initial System Configuration screen
appears as shown in the following figure:

Install GigaVUE-FM on VMware ESXi
Initial GigaVUE-FM Configuration
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0

unconf iqured-gigavue-fm

yes

H.centos.pool .ntp.org 1.centos.poo
4

Provide a unigue hostname for GigaVUE-FM. Note that the hostname may
contain letters, numbers, periods (.), and hyphens (-), but may not begin with a
hyphen. No other special characters are permitted.

Enter the required domain name.

Decide whether to use DHCP for the management interface. Choose one of the

following options:

» If you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS
Servers, and Search Domains are dynamically set up for the management
interface.

e |f you enter no, you must provide the following:

i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.
ii. Inthe DNS Servers field, provide the address of any additional name
servers required. Enter the set of IP addresses with spaces in between.
iii. Inthe Search Domains field, provide the required DNS domains with
spaces in between.

You can choose to either enable or disable NTP. In the Enable NTP field, enter

one of the following:

* Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine
and the NTP server. In the NTP Servers and NTP Version fields, enter the NTP
server address and the version number of the NTP server.

» No—you can skip the next step and directly save your configurations.

f. Select OK to save your configurations.

Install GigaVUE-FM on VMware ESXi

Reboot your GigaVUE-FM virtual machine.

23
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You can now access GigaVUE-FM by opening a browser and entering its IP
address (the IP address you specified).

Add Additional vNIC

Gigamon allows you to configure GigaVUE-FM with two network interfaces—ethO and ethl.
The network interface ethO can be configured to connect to a network used to manage
Gigamon devices. The other network interface ethl can be configured to connect to a
network hosting different servers like SMTP server, Archive server, and so on.

To add an additional vNIC:

1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to Figure
1vSphere Client: Edit Settings.

5 () vesaSs-aaa-26-40 GigaVUE-FMS50-22-89
B [ =20
o[ w000 =y Summary | Resource Allocation | Performance .| Tasks & Events | Alarms .| Console. Permissions-| Maps | Storage Views
& closo ab

Power v What is a Virtual Machine?
Guest L A virtual machine is a software computer that, like a
Snapshot L physical computer, runs an operating system and Virtual Machines

Open Console applications. An operating system installed on a virtual b

@ Edit Seftings.. machine is called a guesl operating system. s

Bl Migrare... Because every virtual machine is an isolated computing Cluster |55
Upgrade Virtual Hardware environment, you can use virtual machines as desktop or

workstation environments, as testing environments, or to

& Clone.. consolidate server applications

Templat >
emplote In vCenter Server, virlual machines run on hosts or

Fault Tolerance v clusters. The same host can run many virtual machines.
M Storage Profile [ l-| : Datacente:
Add Permission... Cil-P vCenter Server
Alarm 3 Basic Tasks vSphere Client
Report Performance... [+ Power on the virtual machine
Rename £ Edit virtual machine settings
Open in Mew Window.,,  CirleAlts M Explore Further
Remove from Inventory
Delete fram Disk =/ Learn more about virtual machines
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Figure 11 vSphere Client: Edit Settings
2. Inthe Hardware tab, click Add.

3. Inthe Add Hardware dialog box, select Ethernet Adapter and then click Next.Refer to
Figure 12vSphere Client: Selecting Ethernet Adapter.
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r@ Add Hardware = l J [

Device Type
[l What sort of device do you wish to add to your virtual machine?
Device Type Choose the type of device you wish to add.
Metwork connection
Ready to Complete — .
' ¥ p 6D serial Port Information
i ) Parallel Port This device can be added to this Virtual Machine.

= Floppy Drive

(25 co/ovo Drive

) USE Controller

USE Device {unavailable)
[l PCI Device (unavailable)

(3 5CSI Device (Unavailable)

Help | < Back | Mext > I Cancel |

Figure 12 vSphere Client: Selecting Ethernet Adapter

4. In the Adapter Type drop-down list, select an appropriate adapter type. Refer to Figure
13vSphere Client: Selecting Device Type.
(&) Add Hardware - l J . (>

Metwork Type
| What type of network do you want to add?

Device Type [~ Adapter Type
Metwork connection Type: IVMXNEFS -
Ready to Complete
| Adapter choice can affect both networking performance and migration compatibility.
| Consultthe VMware KnowledgeBase for more information on choosing among the
network adapters supported for various guest operating systems and hosts.

—MNetwork Connection
' Named network with specified label:
I\'M Netwark LI

 Legacy network:

| =l

Legacy network types are not fully compatible with migration between hosts.

Device Status
’7|7 Connect at power on

Help < Back | Mext > I Cancel |

Figure 13 vSphere Client: Selecting Device Type

5. In the Named network with specified label drop-down list, select an appropriate
network and click Next.

The Network adapter 2 is added to GigaVUE-FM.

Increase the Memory

Based on the requirement, you can increase the memory of the GigaVUE-FM instance.

To increase the memory:
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1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to Figure
14vSphere Client: Edit Settings.

3 [ vesa55-aaa.26-40
B [ =20
= H 1021020.17
1 [Gigay

mmary | Resource Allocation

Pewer

Guest
Snapshot
Open Console

3 ‘What is a Virtual Machine?

A virtual machine is a software computer that, like a
L physical computer, runs an operating system and
applications. An operating system installed on a virtual

Edit Settings...

machine is called a guesl operaling system.

Migrate..
Upgrade Virtual Hardware

B EDE

Clone..
Template

Fault Tolerance
WM Storage Profile

Add Permission..,
Alarm

Report Performance...
Rename
Open in New Windou...

Remove from Tnventery
Delete from Disk

Crel+P

CorleAlte N

Because every virtual machine is an isolated computing
environment, you can use virtual machines as desktop or
workstation environments, as testing environments, or to
consolidate server applications

In vCenter Server, virtual machines run on hosts or
L4 clusters. The same host can run many virtual machines,

Basic Tasks
[» Power on the virtual machine

B Edit virtual machine settings

Figure 14 vSphere Client: Edit Settings

2. Inthe Hardware tab, select Memory.

In Memory Configuration, increase the size of the memory as per your requirement.

Parformance | Tazks & Events | Alarme | Coneole. | Permissions | Mape | Stol

close tab [%]

Virtual Machines

Cluster |5

Host

| Datacenter
vienter Server

vSphere Client

Explore Further

| Learn more about virtual machines
| Learn how to install an operating system

Refer to the recommended size for your guest OS in the dialog box. Refer to Figure
15vSphere Client: Increasing Memory.

@ GigaVUE-FM350-22-89 - Virtual Machine Properties

Hardware IOpﬁnns I Resources I Profiles I vServices I
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@ SCSI controller 0 Paravirtual

% CD/DVD drive 1 [datastorel] GigaVUE-..
&2 Hard disk1 Virtual Disk

BB Network adapter1 WM Network

BB Network adapter2 WM Network

Help
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Virtual Machine Version: 8
—Memery Configuration
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Figure 15 vSphere Client: Increasing Memory

4. Click OK.
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Add vCPUs

Based on the requirement, you can add additional vCPUs to the GigaVUE-FM instance.
1. Right-click the GigaVUE-FM instance and select Edit Settings...
2. In the Hardware tab, select CPUs. Refer to Figure ToevSphere Client: Adding vCPUs.

(%) GigaVUE-FM50-22-89 - Virtual Machine Properties =RREN
Herdware | Options | Resources | Profies | vservices | Virtual Machine Version: 8
™ show All Devices Add... Remove Number of virtual sockets: |1 =
Hardware | Summary | Number of cores per socket: Iz -
Wl Memory 8192 MB
O cros 2 | Total number of cores: 2
Video card Video card A o o N I —
- Changing the number of virtual CPUs after the guest
= VMCldevice Restricted 05 is installed might make your virtual machine
| @ scsicontrollero Paravirtual unstable.
% CD/DVD drive 1 [datastorel] GigaVUE-...
&= Hard disk1 Virtual Disk The virtual CPU configuration specified on this page
B Network adapter1 VM Network might violate the license of the guest OS.
B3 Network adapter2 VM Network
|
N
Help [s]4 Cancel |

Figure 16 vSphere Client: Adding vCPUs
3. In the Number of virtual sockets field, enter the appropriate number of sockets.

4. In the Number of cores per socket field, enter the appropriate number of cores per
socket.

5. Click OK.

To install a third-party certificate on GigaVUE-FM, refer to the following sections:

e Pre-requisites
e Steps

Pre-requisites

Refer to the following pre-requisites:
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» Take a backup of the default system self-signed certificate and key contents before
replacing them with third-party certificate and key. The files are available in the following
folders:

e localhost.crt: /etc/pki/tls/certs/localhost.crt
e localhost.key: /etc/pki/tls/private/localhost.key
* When replacing the certificate key and file ensure to adhere to the following naming
convention:
o For Certificate: localhost.crt
o For Certificate Key: localhost.key
* When you copy the contents of the certificate file, do not delete the EOL characters at the
end of each line. If there is no EOL character at the end of certificate file, insert one.

e |n case of chain of certificates, bundle the server, intermediate, and root certificates into a
single certificate file before replacing the localhost.crt.

e For chain of certificates, add the SSLCertificateChainFile directive to
/etc/httpd/conf.d/ssl.conf: sudo vim /etc/httpd/conf.d/ssl.conf. Add the following
line:ssLCertificateChainFile /etc/pki/tls/certs/localhost.crt.

Steps

Generate the certificate and a private key file in pem format. Use the following command on
Linux or a Linux app (such as Cygwin) for generating the files:

openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout privatekey.pem -out
certificate.pem

Copy the contents of the certificate file.

To install the certificates:
1. Login to the GigaVUE-FM CLI.
2. Execute the following steps from the shell prompt as a root user (sudo):

o Replace SSLCertificateFile: /ete/pki/tls/certs/localhost.crt

o Replace SSLCertificateKeyFile: /etc/pki/tls/private/localhost.key

o Provide access to certificate: chmod 644

o Provide access to key: chmod 600

o Configure GigaVUE-FM load balancer functionality:
cat /etc/pki/tls/certs/localhost.crt
/etc/pki/tls/private/localhost.key > /etc/pki/tls/certs/localhost.pem

systemctl reload haproxy.service

o Restart apache as root: systemctl restart httpd.service

o After restarting, ensure tomcat is up and running: sudo systemctl status
tomcat@cms. service

The system will now start using the newly installed certificate.
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GigaVUE-FM uses a public key (cms.pl12 file) to encrypt the Security Assertion Markup
Language (SAML) messages. You can either use the default public key available in
GigaVUE-FM or generate a new public key using the following command:

sudo openssl pkcsl2 -export -name CMS -out /etc/gigamon/cms.pl2 -inkey
/etc/pki/tls/private/localhost.key -in /etc/pki/tls/certs/localhost.crt -
passout pass:cmsl23

You will be prompted for a pass phrase for the localhost.crt.

After the public key (cms.pl12 file) is generated, place the file in the fetc/gigamon directory.
Change the access rights to chmod 644.

Install GigaVUE-FM on AWS

You can deploy GigaVUE-FM using the AWS CloudFormation Templates (CFT) found in the
AWS Marketplace or deploy the latest GigaVUE-FM instance manually using the public
images (AMI) through the AWS EC2.

You can launch GigaVUE-FM in AWS using one of the following methods:

e Launch GigaVUE-FM using CFT
e Launch GigaVUE-FM using an Instance in AM|

Launch GigaVUE-FM using CFT

Refer to the following topics for details:

e Launch GigaVUE-FM from AWS Marketplace
» Configure an AWS CloudFormation Stack

Launch GigaVUE-FM from AWS Marketplace

To launch the GigaVUE-FM instance from the AWS Marketplace:

Login to your AWS account.

Go to https://aws.amazon.com/marketplace/.

In the Search field, type Gigamon and click Search.

Select the latest GigaVUE Cloud Suite version link from the list for Gigamon products.

Click Continue to Subscribe. The Subscribe to this software page is displayed, where
the complete detail about the product is described.

Click Continue to Configuration. The Configure this software page is displayed.

I S R

)
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7. In the Configure this software page, select the following:

a. From the Fulfillment option drop-down list, select Auto Deploy GigaVUE-FM
using AWS CFT.

b. From the Software version drop-down list, select the latest version.
c. From the Region drop-down list, select the appropriate region.
d. Click Continue to Launch. The Launch this Software page is displayed.

8. In the Launch this Software page, from the Choose Action drop-down, select Launch
CloudFormation.

9. Click Launch. The Create Stack page is displayed.
Configure an AWS CloudFormation Stack

To configure CloudFormation Stack:

1. In the Create Stack page, enter or select the following details:
a. Specify a Template and Template source for the Stack.
b. Click Next. The Specify stack details page is displayed.
2. In the Specify stack details page, enter or select the following details:
a. In the Stack name field, enter a name for the stack.
b. Enter or select the following details for the Parameters.

Fields Action

GigaVUE-FM Instance Configuration

Instance Type Select mé4.xlarge as the minimum instance type for GigaVUE-FM

NoTE: Do not select the t2 instance types as they are not supported. ’

Key Pair Select the name of an existing Amazon EC2 key pair.

Volume Size The default volume size is 40 GB. You can change the volume size based
on your requirement.

GigaVUE-FM Network Configuration
VPC ID Select the existing VPC ID.

Subnet Select the existing public subnet ID.

GigaVUE-FM Security Group Configuration

SSH Location Enter the IP address or subnet that requires SSH access to the GigaVUE-
FM instance.

CIDR IP Enter the CIDR block where GigaVUE-FM would be deployed to allow
mManagement port access to the other components.

c. Click Next. The Configure stack options page is displayed.
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3. In the Configure stack options page, enter or select the following details.

a.

b.

e.

In the Tags section, enter the key and value pairs. Click Add tag to add new tags
and click Remove to remove tags.

In the Permissions section, select the IAM roles for the CloudFormation. Refer to
the AMI and Permissions topic in the GigaVUE Cloud Suite for AWS Guide for
detailed information on the required IAM roles.

In the Stack failure options section, select a behavior for stack failures.

In the Advanced options section, select the required stack policy and notification
options.

Click Next. The Review page is displayed.

4. In the Review page, review the complete details and then select the | acknowledge
that AWS CloudFormation might create IAM resources check box.

5. Click Create Stack to deploy GigaVUE-FM in AWS.

Launch GigaVUE-FM using an Instance in AMI

To launch GigaVUE-FM using a public image:

1. Login to the AWS EC2.
2. From the navigation pane, select Images > AMlIs. The Amazon Machine Images
(AMIs) page appears.

3. Select the latest GigaVUE-FM public image and click Launch instance from image.
The Instance launch wizard is displayed.
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4. In the Instance Launch wizard, select or enter the details in the respective tabs. Refer
to the following table for details.

Fields Action

1. Choose AMI

Select the latest GigaVUE-FM public image.

2. Choose Instance Type

Select m4.xlarge as the minimum instance type for GigaVUE-FM

NoTE: Do not select the t2 instance types as they are not supported.

3. Configure Instance

Select the instance details by your requirements like VPC, Subnet
(management network), IAM Role, and more.

Refer to the AMI and Permissions topic in the GigaVUE Cloud Suite for
AWS Guide for detailed information on the required IAM roles.

E e You can also launch your instance into an Auto Scaling Group.

e You can launch multiple instances from the same AMI.

4, Add Storage

Select Add New Volume, select a Snapshot, and enter 40 (GiB) as the Size
for the new volume in addition to the Root volume 40 (GiB).

5. Add Tags

Enter the key-value pair information for the instances and volumes.

6. Configure Security

Select an existing security group or select the protocol type, CIDR IP, and

Group other details for a new security group. For security group values, refer to the
Security Group topic in the GigaVUE Cloud Suite for AWS Guide.
7. Review Review your instance launch details.

5. In the Review tab, click Launch.

If the page prompts you to specify key pair, select an existing key pair from the drop-down

or create a new key pair.

Initial GigaVUE-FM Configuration

It may take several minutes for the GigaVUE-FM instance to initialize. After the initialization
is completed, you can verify the instance through the web interface as follows:

1. Inyour EC2 Instances page, select the launched GigaVUE-FM instance and expand the
page in the Descriptions tab to view the instance information.

2. Copy and paste the Public IP address into a new browser window or tab.

3. Copy the Instance ID from the Descriptions tab.

If GigaVUE-FM is deployed inside AWS, use admin as the username and the Instance ID as
the default password for the admin user to login to GigaVUE-FM, for example i-
079173111e2d73753 (Instance ID).

password.

E If GigaVUE-FM is deployed outside the AWS, use admin123All as the default admin

Initial GigaVUE-FM Configuration
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After logging into GigaVUE-FM, you are prompted to change the default password.

Install GigaVUE-FM on Azure

The GigaVUE-FM can be launched from the Azure VM dashboard or Azure Marketplace. The
following instructions describes how to launch GigaVUE-FM in your VNet from the Azure VM
Dashboard. Refer to Create a Linux virtual machine in the Azure and Create a Windows
virtual machine in the Azure topics in Azure Documentation for more information.

In the Virtual Machines page, click Create to create an Azure Virtual Machine. The following
table describes the important fields.

Parameter Description

Basics

Subscription

Select your subscription.

Resource Group

Select an existing resource group or create a new security group. For more
information, refer to Create a resource group topic in the Azure Documentation.

Virtual machine name

Enter a name for the VM.

Region Select a region for Azure VM.

Image Select the latest GigaVUE-FM images.
NOTE: You cannot select multiple images for a VM. Refer to Configure GigaVUE
Fabric Components in Azure for more details on configuring GigaVUE V Series
Node, GigaVUE V Series Proxy, and G-vTAP Controller in Azure.

Size For V Series 2 configuration, the recommended instance types are as follows:

e GigaVUE-FM - Standard_D4s_v3

e G-VTAP Controller - Standard_BIms
e V Series Node - Standard_D4s_v4

e V Series Proxy - Standard_BIms

For the V Series 1 configuration, the recommmended instance types are as follows:

e GigaVUE-FM - Standard_DS2_v2

e G-VTAP Controller - Standard_B1s
e V Series Node - Standard_DS2_v2
e V Series Controller - Standard_Bls

Authentication Type

Select an authentication type.

e SSH public key
o Enter the administrator username for the VM.
o Enter the SSH public key pair name.

Install GigaVUE-FM on Azure
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Parameter Description

e Password
o Enter the administrator username for the VM.
o Enter the administrator password.
Disks
Disk Size The required disk size for GigaVUE-FM is 2 x 40GB.
Networking
Virtual Network Select an existing VNet or create a new VNet. For more information, refer to Create
a virtual network topic in the Azure Documentation.
On selecting an existing VNet, the Subnet and the Public IP values are auto-
populated.
Configure network Select an existing network security group or create a new network security group.
security group For more information, refer to Network Security Groups. Configure the Network
Security Group to allow GigaVUE-FM to commmunicate with the rest of the
components.

NoTE: Verify the summary before proceeding to create. It will take several minutes
for the VM to initialize. After the initialization is completed, you can verify the VM
through the Web interface.

After the VM deployment, navigate to the VM overview page, copy the Public IP address,
and paste it in a new web browser tab.

If GigaVUE-FM is deployed in Azure, use adminl123A! as the password for the admin user to
login to GigaVUE-FM. You must change the default password after logging in to
GigaVUE-FM.
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Install GigaVUE-FM on
OpenStack

To launch the GigaVUE-FM instance inside the cloud:

1.
2.

10.

11.
12.

Install GigaVUE-FM on OpenStack

Log into Horizon.

From the Horizon GUI, select the appropriate project, and select Compute > Images.
The list of existing images is displayed.

Select the GigaVUE-FM image and click Launch. The Launch Instance dialog box is
displayed.
In the Details tab, enter the following information and Click Next.

Parameter Attribute

Instance Name Initial hostname for the instance
Availability Zone Availability zone where the image will be deployed.
Count Number of instances to be launched

In the Source tab, verify that the selected GigaVUE-FM image is displayed under
Allocated section and click Next.

In the Flavor tab, select a flavor complying the Minimum Compute Requirements and
then move the flavor from the Available section to the Allocated section. The selected
GigaVUE-FM flavor is displayed under Allocated and click Next.

In the Networks tab, select the specific network for the GigaVUE-FM instance from the
Available section and then move the Network to the Allocated section. The selected
network is displayed under Allocated and Click Next.

In the Network Ports tab, click Next again.

In the Security Groups tab, select the appropriate security group for the GigaVUE-FM
instance from the Available section and then move the Security Group to the
Allocated section. For information about the security groups, refer to Security Group.
The selected security group is displayed under Allocated. Click Next.

In the Key Pair tab, select the existing key pair from the Available section and then
move the Key Pair to the Allocated section. or create a new key pair. For information
about the key pairs, refer to Key Pairs. The selected key pair is displayed under
Allocated. Click Next.

Click Launch Instance. The GigaVUE-FM instance takes few minutes to fully initialize.

From the Horizon GUI, navigate to Compute > Instances. You can view the launched
instance displayed in the Instances page. During the initial boot-up sequence, click
Associate Floating IP. The Manage Floating IP Associations dialog box appears.
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13. In the Manage Floating IP Associations dialog box, enter the following information and
click Associate.

Parameter Attribute

IP Address Floating IP address of the instance

Port to be associated Port for the GigaVUE-FM instance
The Floating IP is then displayed in the IP Address column of the corresponding
Instance.
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After you have deployed a new GigaVUE-FM instance, you need to perform an initial
configuration before you can start using GigaVUE-FM. This is a one-time activity that must
be performed for each GigaVUE-FM instance deployed.

From the Horizon GUI, navigate to Compute > Instances.

2. In the Instances page, click the GigaVUE-FM instance name. The GigaVUE-FM instance
Overview tab is displayed by default.

3. Click the Console tab and the Instance Console appears.

4. Log in as admin with password as admin123A!l and then the console prompts you to

change the default password.

CentOS Linux 7V (Core)
Kernel 3.18.8-16862.9.1.el17.=x86_641 on an x86_64

123 login:

CentOS Linux 7V (Core)
Kernel 3.18.8-16862.9.1.el17.=x86_641 on an x86_64

123 login: admin

Password:

You are required to change your password immediately (root enforced)
Changing password for admin.

(current) UNIX password:

New password:

Retype new password:

[admin@1Z23 ~15

NOTE: You can also choose to perform the IP Networking and NTP
configurations by running the fmctl jump-start command after you power on
the GigaVUE-FM instance

5. To access GigaVUE-FM GUI, enter wget -q -O - http://169.254.169.254/latest/meta-
data/instance-id command in the Instance Console and retrieve the instance ID in the
format of i-000000## which is the default password for the admin user. If GigaVUE-FM
is deployed inside OpenStack, use the Instance ID as the password for the admin user
to login to GigaVUE-FM, however if GigaVUE-FM is deployed outside OpenStack, use
admin123All as the default admin password.

To launch the GigaVUE-FM instance from the Prism Central:
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1. Log in to Prism Central.

2. In Prism Central, select Dashboard > Virtual Infrastructure > VMs. The VMs page
appears.

3. On the VMs page, click Create VM. The Create VM window appears.

NoTE: If the device has more than one cluster, select the required cluster in the
Cluster Selection window.

4. Enter or select the values as described in the following table.

Field Description

General Configuration « Name—name for the VM.

« Description—description for the VM.

o Timezone—time zone from the drop-down list.

Compute Details e VCPU(s)—number of vCPUs required.
¢ Number Of Cores Per vCPU—number of cores per vCPU.

« Memory—memory size of the vCPU(s). Minimum value is 8GiB.

Disks Add, edit or delete the disks. Add the GigaVUE-FM gcow?2 disk image
and a Container (second disk), minimum of 40GB for the VM.You
must select the fabric immage as Boot Device.

Network Adapters (NIC) Add, edit or delete the NIC.

VM Host Affinity Set Affinity by choosing the required nodes to run GigaVUE-FM or a
particular VM.

5. Click Save and the new VM appears on the VMs list with the Power State as Off.
6. Select the new VM and then select Actions > Power On. The new VM is now Active.

7. Select the new VM and then select Actions > Launch console. The GigaVUE-FM
console appears.

8. Log in to the GigaVUE-FM console as admin with the default password admin123All
and you are requested to change the password.

Install GigaVUE-FM Instance for
Kubernetes

You must have a GigaVUE-FM instance launched in your environment. Refer to the
GigaVUE-FM Installation Guide and GigaVUE Fabric Management Guide for details on
installing and launching GigaVUE-FM.
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Install GigaVUE-FM on MS Hyper-
V

This section describes how to install and configure GigaVUE-FM in a Microsoft Hyper-V
environment. It consists of the following main sections:

» System Requirements describes the hardware requirements.

« Install GigaVUE-FM for Microsoft Hyper-V describes the steps to install and deploy
GigaVUE-FM.

System Requirements

This section describes the hardware and virtual computing requirements for GigaVUE-FM.
Before installing GigaVUE-FM, ensure that a supported version of Windows Server is
installed on hardware that meets minimum requirements (see Windows Server Hardware
Requirements for hardware requirements).

Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the trending data
that is captured.

The Hyper-V implementations provided by the following Windows Server versions have
been tested and found to operate acceptably with GigaVUE-FM:

=  Windows Server 2012 R2 and later

Windows Server Hardware Requirements

The following table describes the minimum requirements for the hardware on which
Microsoft Hyper-V runs GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor Microsoft Hyper-V

CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT
or AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization
must be enabled. Make sure that the BIOS option for
virtualization support is not disabled. For more information, see
your BIOS documentation
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Minimum Hardware Requirements

RAM At least 16GB

Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or locally
attached storage (PATA, SATA, SCSI).

NOTE: Increase the disk space depending on the
configuration load requirements for the given GigaVUE-
FM instance.

Network At least one 1Gb NIC

NoTE: Refer to the Microsoft documentation for information on enabling Hyper-V.

The following table lists the virtual computing resources that the Windows Server must
provide for each GigaVUE-FM instance.

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory

Virtual CPU 2 vCPU

Virtual Storage for 84GB Virtual IDE (the Hyper-V default)
Guest e System Disk - 40GB

e Swap Disk - 4GB
e Data Disk - 40GB

Virtual Network 1VvNIC using Hyper-V Virtualized NIC (the Hyper-V default)
Interfaces

Install GigaVUE-FM for Microsoft Hyper-V

The GigaVUE-FM software package for Microsoft Hyper-V environments is distributed as an
ISO image file. The following sections describes how to deploy a fresh installation of
GigaVUE-FM on a Hyper-V host and perform its initial configuration:

» Install GigaVUE-FM from an ISO Image File
» Initial GigaVUE-FM Configuration

Install GigaVUE-FM from an ISO Image File

Use the Hyper-V Manager to install the GigaVUE-FM ISO image file.

NoTe: The ISO image file must be stored in a location that is accessible to the Hyper-V Manager.

To create the Virtual Machine for GigaVUE-FM in Microsoft Hyper-V:
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1. Click Start > Administrative Tools > Hyper-V Manager to open the Hyper-V Manager.

2. From the Actions pane, click New > Virtual Machine. Refer to Figure 10pening the
Virtual Machine Wizard.

The New Virtual Machine Wizard opens.

File Action View Help
+ = a[m
55 HyperV Manager H Actions
|I:| W2D12-HvDER] | Wirtual > N
New v Virtual Machine... m - A
Usage  Assigned Memo Uptime
Import Virtual Machine... Hard Disk... 2 2 24 A New 4
Hyper-V Settings... L Floppy Disk... Lep Import Virtual Machine...
Virtual Switch Manager... %] Hyper-V Settings...
Virtual SAN Manager... L Y% Virtual Switch Manager...
Edit Disk.. (& |l Virtual SAN Manzger...
Inspect Disk... o Edit Disk...
Stop Serviee The selected vitual;achins e o checkpoits. 5 Inspect Disk... -
Remove Server (W) Stop Service
Refresh 7 Remove Server
View » U Refresh
Help ket View »
Created:  8/10/2015 32714 PM Clustered:  No H Hep
Version: 5.0 | FMVM 3 'l‘ﬁ_i
Generation: 1
" =] Connect...
Notes: None —
B4 Settings..
© stat
Summary |Munwy|Ndwu1r‘ng| Replication | §s Checkpoint
<| [ 5 | B Move.. |
Displays the New Virtual Machine Wizard.

Figure1 Opening the Virtual Machine Wizard

3. Read the notes on the Before You Begin screen (refer to Figure 2Before You Begin
Screen), and then click Next to continue.

This wizard helps you create a virtual machine. You can use virtual machines in place of physical
. computers for a variety of uses. You can use this wizard to configure the virtual machine now, and
Spedify Name and Location you can change the configuration later wsing Hyper-V Manager.

Sr=liEareeaiy To create a virtusl madhine, do one of the folowing:
Assign Memaory -
Configure Networking R Rt e e i e i Yo
Gonnect Virtusl Hard Disk
Installation Options
Summary

[] Do not show this page again

| < Previous | | Mext > | | Finish | | Cancel

Figure 2 Before You Begin Screen

4. After the Specify Name and Location page of the New Virtual Machine Wizard opens
as shown in Figure 3Name and Location Page, do the following:

Install GigaVUE-FM on MS Hyper-V 4]
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a. Supply a descriptive name for the GigaVUE-FM virtual machine in the Name field.

By default, the virtual machine will be stored in the default configuration folder
shown in the Location text box. You can change this default location by checking
the Store the virtual machine in a different location check box and providing a
custom path.

b. Click Next to continue.

2
ﬁ Spedify Name and Location

Before You Begin Chioose a name and location for this virtual machine.

Spedfy Name and Location The name is displayed in Hyper-¥ Manager. We recommend that you use a name that helps you easily
identify this virtual machine, such as the name of the guest operating system or workload.

You can create a folder or use an existing folder to store the virtual machine, If you don't select a
folder, the virtual machine is stored in the default folder configured for this server.

[] store the virtual machine in a different location

Location: |C :\ProgramDataMicrosoft\Windows Hyper -V, | | Browse...

m If you plan to take chedkpoints of this virtual machine, select a location that has enough free
space. Checkpoints indude virtual machine data and may require a large amount of space.

[ <previous | [ next> | [ Fnsh | [ concel

Figure 3 Name and Location Page

5. On the Specify Generation page of the New Virtual Machine Wizard, select
Generation 1 as shown in Figure 4Specify Generation Page

NOTE: It isimportant to select Generation 1 and not Generation 2. Selecting
Generation 2 may lead to failure of the GigaVUE-FM installation process
because the CD Drive is presented as an SCSI device and not IDE.
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i
ﬁ Specify Generation

Before You Begin Choose the generation of this virtual machine.

gredfiancand ooty ® Generation 1

Specify Generation This virtual machine generation provides the same virtual hardware to the virtual machine as in

P ey previows versions of Hyper-V.

Canfigure Netwarking ) Generation 2

conwtwnad | T e s S
Installation Options Windows Server 2012 or 64-bit versions of Windows 8.

Summary i\ Once a virtual machine has been created, you cannot change its generation,

[ <previous | [ wext> |[ Fmen | [ cancel

Figure 4 Specify Generation Page

6. Click Next to continue.

The Assign Memory page of the New Virtual Machine Wizardopens, which is shown

in Figure 5Assign Memory Page.
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Before You Begin Spedfy the amount of memory to allocate to this virtual machine. You can specify an amount from 32
MB through 125433 MB. To improve performance, specfy more than the minimum amaount
recommended for the operating system.

Spedfy Generation Startup memary: -

Assign Memory
Configure Metworking
Connect Virtual Hard Disk

Spedfy Mame and Location

[ ] Use Dynamic Memary for this virtual machine.

When you decde how much memory to assign to a virtual machine, consider how you intend to
use the virtual machine and the operating system that it will run.

Installation Options
Summary

Figure 5 Assign Memory Page

7. Change the Memory assigned to this virtual machine to 16384 MB, and then click Next
to continue.

The Configure Networking page of the New Virtual Machine Wizardopens, which is
shown in Figure 6Configure Networking Page.
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ol
ﬁ Configure Networking

Before You Begin Each new wvirtual machine indudes a network adapter. You can configure the network adapter to use a

Spedify - virtual switch, or it can remain disconnected.

Specify Generation Connection: | Intel(R) 1350 Gigabit Network Connection - Virtual Switch v |

Assign Memaory

Canfigure Networking

[ <previous | [ mext> || Fnsh || cones

Figure 6 Configure Networking Page

8. From the Connection drop-down list, select the virtual network to which GigaVUE-FM
will connect to, and then click Next to continue.

The Connect Virtual Hard Diskpage of the New Virtual Machine Wizard opens, which
is shown in Figure 7Connect Virtual Hard Disk Page.

pl
ﬁ Connect Virtual Hard Disk

Before You Begin A virtual machine requires storage so that you can install an operating system. You can specify the
Spedify e storage now or configure it later by modifying the virtual machine’s properties.

Specify Generation ®) Create a virtual hard disk
Assian M - Use this option to create a VHDX dynamically expanding virtual hard disk,

Name: |FM,\chd)< |
Location: [C:\Users\Public\Documents HyperV\Virtual Hard Disks\ || rowse...
Installation Options _
Size: 41| GB (Maximum: 64 TB)
S

() Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Connect Virtual Hard Disk

Location: |C:!ugers‘Puinc\DocumentSHvDer-v\Wrmal Hard Disks, Browss. ..

() Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later,

[ <previous | [ wext> |[ Fnsh | [ conce

Figure 7 Connect Virtual Hard Disk Page

9. Select the Create a virtual hard disk option and set the Size to 41 GB.
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You can accept the default Name and Location or customize them according to your
needs. When you have finished, click Next to continue.

The Installation Options page of the New Virtual Machine Wizardopens, which is

shown in Figure 8lInstall Options Page.

10. Use this dialog box to select the ISO image file for GigaVUE-FM. As shown in the figure
Figure 8Install Options Page, set the following options:

a. Select the option Install an operating system from a bootable CD/DVD-ROM.

b. Set the Media option to Image file (.iso).

c. Use the Browse button to navigate to the GigaVUE-FM ISO image file.

d. Click Next to continue.

ﬁ Installation Options

Before You Begin

Specify Name and Location
Sperify Generation
Assign Memory

Configure Networking
Connect Virtual Hard Disk

Installation Options

‘You can install an operating system now if you have access to the setup media, or you can install it
later,

() Install an operating system later

(®) Install an operating system from a bootable CD/DVD-ROM
Media
() Physical CD/OVD drive: | |

®) Image file (is0):

() Install an operating system from a bootable fioppy disk
Media

virtual floppy disk (. vid): Browse. ..

() Install an operating system from a network-based installation server

[ <previeus | [ mext> |[ Fmsh | [ conce

Figure 8 [nstall Options Page

After you click Next, the summary page of the New Virtual Machine Wizardopens,
showing the settings that you configured for the GigaVUE-FM virtual machine. An

example is shown in Figure 9Summary Page.
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LS
e
ﬁ Completing the New Virtual Machine Wizard

Before You Begin You have successfuly completed the New Virtual Machine Wizard. You are about to create the
Specify Name and Location AT
Specify Generation Description:
Assign Memory MName: FM
= Generation: Generation 1

Con Networking

SIss Memory: 4096 MB
Connect Virtual Hard Disk Network: Intel(R) 1350 Gigabit Network Connection - Virtual Switch

Installation Options Hard Disk: C:\Jsers\Public\Documents\Hyper-V\Virtual Hard Disks\FM.vhdx (VHDX, dynamici

Operating System: Wil be installed from C:\Users'\Administrator\Downloads\fma.iso
<] m >

To create the virtual machine and dose the wizard, dick Finish.

<Pmms|| Next > Finish || Cancel

Figure 9 Summary Page

1. Click Finish to create the GigaVUE-FM virtual machine as configured. Alternatively, you

can use the Previous button to go back and change settings.

The New Virtual Machine Wizard only creates the GigaVUE-FM virtual machine,
returning you to the Hyper-V Manager when creation is complete. The new
GigaVUE-FM virtual machine is listed in the Action pane by the name you supplied
during installation.

The procedures given below will take you through the steps of adding an additional
virtual hard disk and actually installing GigaVUE-FM.

Add Additional Virtual Hard Disk and Install GigaVUE-FM

To add an additional virtual hard disk and install GigaVUE-FM:

1. In Hyper-V Manager, from the Actions pane, select the newly added GigaVUE-FM
virtual machine, and then click Settings.

2. In the Settings page, select IDE Controller O.

3. Inthe IDE Controller pane that appears to the right, select Hard Drive, and then click
Add. Refer to the following figure:
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e Import Virtual Machine...
*| Hyper-V Settings...
: Virtual Switch Manager...
ﬁl Virtual SAN Manager...
ﬁ Edit Disk...
E Inspect Disk...
@ Stop Service
x Remove Server
4 Refresh
View 4
n Help

Sa Checkpoint
2 Move..
e Export...

=] Rename..

S Delete..

Y Enable Replication...

I Help

[GigavUE-FM-5.8

4G

% Hardware

~

4@_ Add Hardware
& BIOS
Boot from CD
@ Memary
16384 MB

[+ R Processor

GigaVUE-FM-5.8.vhdx
(= [EE IDE Controller 1
4 DVD Drive

¥ 5CSI Controller
[ @ MNetwork Adapter

T com1

Mone

¥ com2
Mone

[ Diskette Drive
Mone

& +

1 Virtual processeor
= (5] IDE Controller 0 4]
[ = Hard Drive
gigamon-gigavue-fm-5.8.0...

Intel(R) 1350 Gigabit Metwork ...

|I] Mame
GigaVUE-FM-5.8
|ﬁ Integration Services
Some services offered
(ﬁ Chedkpaint File Location

éé Smart Paging File Location

9 Automatic Start Action

Restart if previously running

Figure 10 Navigating to Add Additional Hard Disk
A new Hard Drive entry is added under IDE Controller O.

4. Select the Hard Drive entry.

C:\ProgramDataMicrosoftiWin.. .

C:\ProgramDataMicrosoftiWin.. .

i IDE Controller

“You can add hard drives and CD/DVD drives to your IDE controller.
Select the type of drive you want to attach to the controller and then dick Add.

DD Drive

“You can configure & hard drive to use a virtual hard disk or a physical hard disk after
you attach the drive to the controller.

5. In the Hard Drive pane that appears to the right, select Virtual hard disk, and then
click New as shown in the following figure:
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| GigaVUE-FM-5.8 v 4 b |G

# Hardware

‘{ﬂ Add Hardware
& BIOS ‘You can change how this virtual hard disk iz attached to the virtual machine. If an
Boot from CO operating system is installed on this disk, changing the attachment might prevent the
virtual machine from starting.
i Memory

163534 MB
@ R Processor |IDE Contraller 0 v| | 1 {in use)

1 Virtual processor Media

= il IDE Controller 0 You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
[# & Hard Drive by editing the assodated file. Specify the full path to the file.

GigaVUE-FM-5.8. vhdx Virtual hard disk:

= Hard Drive

Controller: Location:

=5 T_DECon'I:rc'I'Ier ! | Edit | | Inspect | | Browse... |
&% DVD Drive
gigamon-gigavue-fm-5.8.0... () Physical hard disk:

® 5CSI Controller | |

= [H] MNetwork Adapter

Intel(R) 1350 Gigabit Metwork ... ﬂ If the physical hard disk you want to use is not listed, make sure that the
l? coM 1 disk is offline. Use Disk Management on the physical computer to manage
Mone physical hard disks.

3 com2

None To remave the virtual hard disk, didk Remove. This disconnects the disk but does not
_— delete the assodated file.
] Diskette Drive

# Management

m MName
GigaVUE-FM-5.8

|ﬁ Integration Services
Some services offered

@fl Checkpoint File Location
C:'\ProgramDataMicrosoftiwin. ..

ié Smart Paging File Location
C:'\ProgramData\MicrosoftWin. ..

Figure 11 Navigating to the New Virtual Hard Disk Wizard
The New Virtual Hard Disk Wizard opens.
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e
gg Before You Begin

Before You Begin This wizard helps you create a new virtual hard disk. Virtual hard disks provide storage for virtual
Choose Disk Format machines and are stored on physical media as .vhd or .vhdx files,

Choose Disk Type

Spedfy Mame and Location
Configure Disk

Sumrmary

[ po not show thiz page again

< Previous H Mext = || Finish || Cancel

Figure 12 New Virtual Hard Disk Wizard

6. Click Next to go to the Choose Disk Format page of the wizard.

7. Select the required format that you want to use for the virtual hard disk, and then click
Next.

The Choose Disk Type page of the wizard appears.
8. Select the required disk type for the virtual hard disk, and then click Next.
The Specify Name and Location page of the wizard appears.

9. Specify a unique name for the virtual hard disk, and then browse and select the
location where you want to save the disk.

10. Click Next. The Configure Disk page of the wizard appears.
11. You can choose one of the following options to configure the virtual hard disk:

o Create a blank virtual hard disk of size 41 GB.

o Choose a physical hard disk from which you can copy the contents into the new
virtual hard disk.
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o Browse and select a virtual hard disk from which you can copy the contents into the
new virtual hard disk.

12. Click Next to exit the New Virtual Hard Disk Wizard.
13. Click OK. The GigaVUE-FM installation begins as shown in the following figure:

t& GigaVUE-FM-5.8 on WIN-G
File Action Media Clipboard View Help

G O@OO NIk B

MOTE: fibout to install GigaWE-FM on this system.

Writing GigaWE-FM image to boot disk.
This will take at least 18-Z8 minutes. Please wait...

Figure 13 GigaVUE-FM Installation Begins

It may take several minutes for the installation to complete. The system will reboot
after the installation is completed.

Connect and Power On the GigaVUE-FM Virtual Machine

The next step is to connect to the GigaVUE-FM virtual machine from within Hyper-V
Manager and start it. This begins the actual installation of the GigaVUE-FM Virtual Appliance
from the connected ISO image file. Once GigaVUE-FM finishes installing from the ISO image
file, you will then disconnect the ISO image file and restart the virtual machine.

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane, right-click
the GigaVUE-FM virtual machine, and click the Connect option.

2. The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.
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=F Hyper-V Manager = =] =
File Action View Help
¢ =| 2@ HE
33 Hyper-V Manager ! Actions
33 W2012-HYPERV Virtual Machines
= W2012-HYPERV .
MName - State CPU Usage Assigned Memory  Uptime Mew N
3 M Off
u_-inualh1achine...
Ers FM on W2012-HYPERV - Virtual Machine Connection =] IEl et
ettings...
File Action Media View Help itch Manager...
(] By
s o N Manager...
isk... =
sice
Server
»
The virtual machine 'FM' is turned off
. . ~ —
To start the virtual machine, select "Start' from the Action menu
int

3. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual
Machine Connection tool.

4. The GigaVUE-FM virtual machine powers on. You can monitor the progress of the
system start in the Virtual Machine Connection tool.

The system power-on can take several minutes as GigaVUE-FM is installed from the
ISO image file. Disconnect the media before Powering On as shown below:

e FM on W2012-HYPERV - Virtual Machine Connection == -
File Action Clipboard  View Help

-’

Diskette Drive ¥ Insert Disk...

The virtual machine 'FM' is turned off

To start the virtual machine, select "Start’ from the Action menu

Status: Off
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Disconnect the ISO Image File

It is important to disconnect the ISO image file before you power on GigaVUE-FM again so
you don't have to go through the image install process again. Disconnect the ISO image file
as follows:

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane and select
the GigaVUE-FM virtual machine.

2. Inthe Actions pane, click the Settings entry under the GigaVUE-FM virtual machine
name.

A Settings dialog box for the GigaVUE-FM virtual machine appears.

3. Select the DVD Drive entry in the panel on the left of the Settings dialog box and
change its setting from Image file to None, as shown in the figure below.

4. Click the OK button to apply the changes.

This concludes the installation procedure for GigaVUE-FM on Hyper-V. The next step is to
power on the virtual machine and perform its initial configuration, as described in Initial
GigaVUE-FM Configuration .

IMPORTANT: Clear the browser cache before logging in to GigaVUE-FM.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you need to perform an initial
configuration before you can start using GigaVUE-FM. This procedure only needs to be
performed once for each GigaVUE-FM instance deployed.

NoTE: Use Care When Shutting Down or Rebooting GigaVUE-FM. Never directly
Power-Off the virtual machine. For Microsoft Hyper-V environment, you cannot use
any of the reset, or turn-off hooks. Using either of these may lead to corruption that
will prevent proper GigaVUE-FM operation.

The best ways to shutdown a GigaVUE-FM on Hyper-V is to use either Shutdown or
Ctrl+Alt+Del from the Action button on the virtual console.

To perform the initial configuration:

1. Click Start > Administrative Tools > Hyper-V Manager.

NOTE: Make sure you have already disconnected the ISO image file used to
install GigaVUE-FM. Refer to Disconnect the ISO Image File for details.
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2. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM
virtual machine, and click the Connect option. The Virtual Machine Connection tool
opens for the GigaVUE-FM virtual machine.

3. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual
Machine Connection tool. The GigaVUE-FM virtual machine powers on and displays a
login prompt.

4. Log in as admin with password admin123A!. You will be prompted to change your
password. After you change and confirm your password, perform the following steps:

a. Run the fmectl jump-start command. The Initial System Configuration screen
appears as shown in the following figure:

unconf igured-gigawue—fm

yes

H._centoz.pool nip.org 1.centos.poo
4

b. Provide a unique hostname for GigaVUE-FM. Note that the hostname may
contain letters, numbers, periods (.), and hyphens (-), but may not begin with a
hyphen. No other special characters are permitted.
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c. Enter the required domain name.

d. Decide whether to use DHCP for the management interface. Choose one of the
following options:

e |f you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS
Servers, and Search Domains are dynamically set up for the management
interface.

» |f you enter no, you must provide the following:
i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.

ii. Inthe DNS Servers field, provide the address of any additional name
servers required. Enter the set of IP addresses with spaces in between.

iii. Inthe Search Domains field, provide the required DNS domains with
spaces in between.

e. You can choose to either enable or disable NTP. In the Enable NTP field, enter
one of the following:

* Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine
and the NTP server. In the NTP Servers and NTP Version fields, enter the NTP
server address and the version number of the NTP server.

» No—you can skip the next step and directly save your configurations.
f. Select OK to save your configurations.
g. Reboot your GigaVUE-FM virtual machine.

You can now access GigaVUE-FM by opening a browser and entering its IP
address (the IP address you specified).
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Install GigaVUE-FM on KVM

This section describes how to install and configure GigaVUE-FM in a KVM environment. It
consists of the following main sections:

» System Requirements describes the hardware requirements.
» Install GigaVUE-FM for KVM describes the steps to install and deploy GigaVUE-FM.

« Initial GigaVUE-FM Configuration describes the steps to start GigaVUE-FM instance
and configure it.

Limitations

You can install GigaVUE-FM in a KVM environment, but you cannot access GigaVUE-FM
through CLI in a KVM environment using SSH. In KVM, you can only access the GigaVUE-FM
CLI using the VNC console.

System Requirements

This section describes the hardware and virtual computing requirements for GigaVUE-FM.
Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the trending data
that is captured.

Linux Server Hardware Regquirements

The following table describes the minimum requirements for the hardware on which KVM
runs GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor KVM
Supported (tested on previous versions of GigaVUE-FM)
= V200
CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT

or AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization
must be enabled. Make sure that the BIOS option for
virtualization support is not disabled. For more information, see
your BIOS documentation.

Install GigaVUE-FM on KVM 56
Limitations



GigaVUE-FM Installation and Upgrade Guide

Minimum Hardware Requirements

RAM At least 16GB.

Disk Space At least 84GB shared (FC, iSCSI, NFS, or FCoE) or locally
attached storage (PATA, SATA, SCSI).

NOTE: Increase the disk space depending on the
configuration load requirements for the given GigaVUE-
FM instance.

Network At least one 1Gb NIC.

The following table lists the virtual computing resources that the Linux Server must provide
for each GigaVUE-FM instance.

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory
Virtual CPU 2 vCPU

Virtual Storage for 84GB

Guest e System Disk - 40GB

e Swap Disk - 4GB
e Data Disk - 40GB

Virtual Network One vNIC
Interfaces

Supported Browsers

GigaVUE-FM has been tested on the following browsers:

Browser Version

Mozilla Firefox'" « Version 47
Apple® safari® «  Version 9.
Google®Chrome® « Version 52
Microsoft Edge « Version 38

Notes:

¢ Only the browsers that support TLS v1.2 can access GigaVUE-FM.

e Internet Explorer 11 (IE11) is deprecated for security reasons and is no longer supported. |E
users are strongly encouraged to switch to Microsoft Edge.
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Install GigaVUE-FM for KVM

The GigaVUE-FM software package for KVM environments is distributed as an ISO image
file. The following sections describes how to deploy a fresh installation of GigaVUE-FM on a
KVM host and perform its initial configuration:

» Install GigaVUE-FM from an ISO Image File
» Initial GigaVUE-FM Configuration

These steps are only valid for new installations of GigaVUE-FM.

Install GigaVUE-FM from an ISO Image File

Use the Virtual Machine Manager to install the GigaVUE-FM ISO image file.

NoTE: The ISO image file must be stored in a location that is accessible to the Manager.

To create the Virtual Machine for GigaVUE-FM in KVM:

NOTE: These instructions use “Virtual Machine Manager” to create and manage the
virtual machines (VMs).

1. Open the Virtual Machine Manager, and then click the Create a new virtual machine
icon as shown in the following figure:

Virtual Machine Manager

Name a (CPUusage

v QEMU/KVM

The New Virtual Machine Wizard opens.

2. Select Local install media (ISO image or CDROM), and then click Forward to
continue.
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New VM

m Create a new virtual machine

Connection: QEMU/KVM

Choose how you would like to install the operating system

© Local install media (150 image or CDROM)
Network Install (HTTP, FTP, or NFS)
Network Boot (PXE)
Import existing disk image

b Architecture options

Cancel Back Forward

3. Browse and select the location from where to upload the GigaVUE-FM ISO image, and

then select the Automatically detect operating system based on install media

check box.

New VM

m Create a new virtual machine

Locate your install media
Use CDROM or DVD

© Use ISO image:

/home/kvm/gigamon-gigavue-fm-5.9.00-17000; + | | Browse...

Automatically detect operating system based oninstall media

OS type: Unknown
Version: Unknown

Cancel Back Forwa&j

Click Forward to continue.

4. Set the Memory and CPU Settings.
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New VM

m Create a new virtual machine

Choose Memory and CPU settings

Memory (RAM): | 8192 ==
Up to 128567 MIB available on the host

CPUs: | 2 -+

Up to 64 available

Cancel Back ~ For[:sard

Click Forward to continue.

5. Select the Enable storage for this virtual machine check box, and set the Size to
40Gb.

Install GigaVUE-FM on KVM
Install GigaVUE-FM for KVM

60



GigaVUE-FM Installation and Upgrade Guide

New VM

B Create a new virtual machine

Enable storage for this virtual machine

© Create a disk image for the virtual machine

40.0 - <+ | GiB
1794.6 GiB available in the default location

Select or create custom storage

Cancel Back [ Fn%ard J

Click Forward to continue.

6. On the next screen, complete the following:
a. Enter a unigue name for the virtual machine.
b. Select the Customize configuration before install check box.

c. From the Network Selection drop-down list, select the required network
communication option.

d. From the Source mode drop-down list, select Bridge.

e. Click Finish.
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New VM

m Create a new virtual machine

Ready to begin the installation

Mame: | generic
0S: Generic
Install: Local CDROM/ISO
Memory: 8192 MIB
CPUs: 2
Storage: 40.0 GiB /var/lib/libvirt/images/generic.qrow2
Customize configuration before install

« Network selection
Host device enp59s0f0: macvtap »

Source mode: | Bridge ]

In most configurations, macvtap does not
0 work for host ko guest network
communication.

Cancel Back [ Flnﬁﬁ E |

The summary screen appears as shown in the following figure:
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generic on QEMU/KVM

o BeginInstallation Q Cancel Installation

B overview Virtual Disk
G CPUS Source path: fvar/lib/libvirt/images/generic.qcow2
Device type: IDE Disk 1
&% Memory Storage size: Unknown
. Boot Options Readonly:

IDE CDROM 1 ¥ Advanced options N

NIC :77:08:e9 Disk bus: |IDE ’
I Display Spice Serial number: | |
‘ Sound ich6 f
- Storage format: | gcow? |
&= Console

v Performance options

,—:—_'g Channel spice

B video QXL Cache mode: EIH_ypen.risnr default L

ﬁ Controller USB 0 10 mode: | Hypervisor default L

@ ussredirector 1

@ ussredirector2

L Add Hardw.?\ri_e ) _ Remove 3 Cancel Apply

7. Verify the options that you have selected, and then click Add Hardware to add the
second disk.

8. In the Add New Virtual Hardware screen, set the disk size to 40Gb.
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Add New Virtual Hardware
B Storage Storage

M Controller

Network © Create a disk image for the virtual machine

& Input 40.0 — | + | GiB
-- s 1794.6 GiB available in the default location
w Ssound
&l serial select or create custom storage
=&l Parallel Manage.
|| console
o Chapme! Device type: | LJ Disk device
=% USB Host Device
|% PCIHost Device Bustype: |IDE
M video
W watchdog ¥ Advanced options
[ Filesystem Cache mode:  Hypervisor default »
@ Smartcard
@ usB Redirection
& TPM

» RNG

|% Panic Notifier

Cancel

Finish

e

9. Click Finish. The summary screen appears again where you can verify the details of IDE
Disk 2 that you added. Click Begin Installation.

generic on QEMU/KVM

|J Begin Initallatlan | 6 Cancel Installation

123
_ Overview Virtual Disk
D CPUs Source path: /var/lib/libvirt/images/generic.qcow2
; Device type: IDE Disk 1
fn SAMROLY Storage size: Unknown
8 Boot Options Readonly:
Shareable:
_ IDECDROM 1 v Advanced options
T - N . = T
l'_l' IDE Disk 2 Disk bus: |IDE

Ll Serial number: |

Bl Display Spice

i Sound iché

Storage format: | qcow2

w Performance options

g':—i.'g Console f
==, . Cache mode: | Hypervisor default
é=3 Channel spice :

Bl video OXL 10 mode: | Hypervisor default

H Controller USB 0
@ useredirector 1
@ useredirector 2

Add Hardware
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Once the installation is complete, the virtual machine launches.

Initial GigaVUE-FM Configuration

After you have deployed a new GigaVUE-FM instance, you need to perform an initial
configuration before you can start using GigaVUE-FM. This procedure only needs to be
performed once for each GigaVUE-FM instance deployed.
To perform the initial configuration:

1. Open Virtual Machine Manager.

2. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM
virtual machine, and click the Open option.

The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.
3. Open the GigaVUE-FM virtual machine from the Virtual Machine tool.
4. The GigaVUE-FM virtual machine powers on and displays a login prompt.

5. Log in as admin with password admin123A!. You will be prompted to change your
password. After you change and confirm your password, perform the following steps:

a. Run the fmctl jump-start command. The Initial System Configuration screen
appears as shown in the following figure:

unconf iqured-gigavue-fm

yes

H.centos.pool.ntp.org 1.centos.poo
4

b. Provide a unique hostname for GigaVUE-FM. Note that the hostname may
contain letters, numbers, periods (.), and hyphens (-), but may not begin with a
hyphen. No other special characters are permitted.
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c. Enter the required domain name.

d. Decide whether to use DHCP for the management interface. Choose one of the
following options:

e |f you enter yes, the IPv4 Address or IPv6 Address, CIDR, Gateway, DNS
Servers, and Search Domains are dynamically set up for the management
interface.

» |f you enter no, you must provide the following:
i. IPv4 Address or IPv6 Address, and the respective CIDR and Gateway.

ii. Inthe DNS Servers field, provide the address of any additional name
servers required. Enter the set of IP addresses with spaces in between.

iii. Inthe Search Domains field, provide the required DNS domains with
spaces in between.

e. You can choose to either enable or disable NTP. In the Enable NTP field, enter
one of the following:

* Yes—Use NTP to synchronize the time between GigaVUE-FM virtual machine
and the NTP server. In the NTP Servers and NTP Version fields, enter the NTP
server address and the version number of the NTP server.

» No—you can skip the next step and directly save your configurations.
f. Select OK to save your configurations.
g. Reboot your GigaVUE-FM virtual machine.

You can now access GigaVUE-FM by opening a browser and entering its IP
address (the IP address you specified).
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Upgrade GigaVUE-FM

This section describes how to upgrade GigaVUE-FM to the latest revision in either a VMware
ESXi host or in Microsoft HyperV environment.

Before you upgrade, read Important GigaVUE-FM Upgrade Guidance for special
guidelines and caveats related to upgrading from specific versions of GigaVUE-FM.

At a high level, the upgrade process involves the following steps:

1. Before starting an upgrade to GigaVUE-FM, get the latest image, upgrade information,
and Release Notes from the Software & Release Notes download page (login required)
on the Gigamon Community.

2. Be sure to review the GigaVUE Release Notes for the latest release before performing
the upgrade.

» Ensure your environment supports any specified system requirements.

* Check the minimum memory requirements in the new release as they may change
between releases.

3. Once the GigaVUE-FM image is obtained, download it to a server within your
environment. This must be a server that your current GigaVUE-FM instance can access
to upload it.

4. (Important) Save your current configuration using the facilities provided by the
hypervisor before upgrading.

5. Verify that the GigaVUE-FM instance time is set correctly to ensure accuracy of the
trending data that is captured.

6. Perform the upgrade using either the Command-Line Interface (CLI) or the GigaVUE-
FM User Interface (Ul).

7. After upgrading your GigaVUE-FM instance, upgrade your GigaVUE-VM deployments.
Refer to “Bulk Upgrading GigaVUE-VM Nodes” in the GigaVUE Cloud Suite for
VMware—GigaVUE V Series Guide.

Upgrade Methods:

«» Upgrade GigaVUE-FM from the GigaVUE-FM CLI
« Upgrade GigaVUE-FM from the Ul
« How to Use the Snapshot Feature

Supported Upgrade Paths for GigaVUE-FM

The supported upgrade paths for GigaVUE-FM is as follows:
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o 5.8.01>510.02 > 511.01*
o 59.01>511.01*

o 510.02 > 511.071*

o 510.02>512.01**
o 511.01>512.01*

o 511.01>513.00**
o 512.01>513.00**
o 512.01>513.01**

o 513.00 > 5.13.01**
o 512.01>514.00**
o 513.00 > 514.00**
o 513.01>514.00**
o 513.01>515.00**
o 514.00 > 515.00**
o 514.00 > 5.16.00*
o 5.15.00 > 5.16.00**

*Password change is mandated for all passwords during upgrade.
**Password change is only mandated if the current password is using the default
password.

GigaVUE-FM Upgrade Rules and Notes

» Best Practice: Always upgrade your GigaVUE-FM instance before upgrading the
GigaVUE-OS nodes. You can upgrade the attached nodes from the device or from
GigaVUE-FM. The latter is recommended. Refer to “Upgrading Software on a GigaVUE-
FM Node or a Cluster from GigaVUE-FM” in the GigaVUE Fabric Management Guide.

 If upgrading from GigaVUE-FM versions lower than 5.10.xx: You cannot directly
upgrade your GigaVUE-FM instance to release 5.10.00 from a release prior to 5.8.xx. If your
current version of GigaVUE-FM is 5.7.xx or lower and you want to upgrade to software
version 5.13.xx, you must first migrate to GigaVUE-FM 510.xx and then upgrade to 5.11.xx.

NOTE: For instructions on how to migrate refer to Migrate GigaVUE-FM in
GigaVUE 5.10 Documentation.

» If upgrading from GigaVUE-FM versions lower than 5.5.00: While upgrading from any
version lower than 5.5.00, an association of more than one VPort to the same GigaSMART
group needs to be removed for any existing GTP GigaSMART operation.
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» If upgrading from GigaVUE-FM versions lower than 5.4.00: Be aware of the minimum
memory requirement changes between releases. Earlier releases specified 4GB of
memory for the OVA template; whereas versions after 5.4.00 require 8GB and versions
after 5.7.00 require 16GB. If the existing virtual or physical hardware running GigaVUE-FM
is configured with less memory than required, then increase the amount of memory
available to the GigaVUE-FM machine. Refer to GigaVUE-FM Memory and CPU
Requirements in the GigaVUE Release Notes for additional details.

Important GigaVUE-FM Upgrade Guidance

To upgrade GigaVUE-FM, the recommended procedure is to back up your current
configuration and perform the pre-upgrade checks (memory requirements, the maximum
number of images) before installing the image. You can upgrade via the GigaVUE-FM GUI or
CLI. It is recommended that you plan your upgrade before performing any upgrade steps.

Important: Intent-Based Orchestration (IBO) Policies are removed when upgrading from
any pre-5.11 version of GigaVUE-FM to version 5.11.00 or above. IBO Policies will need to be
recreated after upgrading to 5.11.00 or above.

Best Practice: Before performing an upgrade, in addition to taking a backup of GigaVUE-
FM, also take a Sysdump, which provides valuable configuration information that is not
captured in the backup. You can use the Sysdump after the upgrade to troubleshoot any
upgrade-related issues with your configurations.

Post-Upgrade Notes

» Intent Based Orchestration (IBO): IBO Policies are removed when upgrading from any
pre-5.11 version of GigaVUE-FM to version 5.11.00 or above. You must recreate the IBO
Policies after upgrading to 5.11.00 or above. Refer to the "Orchestrated Configurations”
section in the GigaVUE-FM User's Guide details on how to create policy.

» Storage Management: The time period specified for the storage management settings
will be configured to the default values when upgrading to GigaVUE-FM v5.11.xx. After
completing the upgrade, you must reconfigure the time period to the required values.

« Remember to upgrade your GigaVUE-VM deployments: When upgrading GigaVUE-FM,
you must also upgrade your GigaVUE-VM deployments. For the steps to upgrade
GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” section in the GigaVUE
Cloud Suite for VMware—GigaVUE V Series Guide.
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» Tags Applied to Resources: After you upgrade to software version 5.11.0.0, duplicate tag
values will not get associated to nodes and ports while adding and removing nodes from
the clusters. However, the existing duplicate tags on the resources do not get cleaned up
as part of the upgrade. You must run the following script (bundled with 5.11) to remove
the duplicate tags of nodes/clusters and ports.

Script name: duplicate_tags_removal.

NOTE: It is recommended that a sudo privileged user runs this script. The default
admin user is a sudo privileged user.

To run the script:

1. SSH to GigaVUE-FM.
2. Execute sudo duplicate_tags_removal.
3. You can see the logs in the console.

GigaVUE-FM Migration Guidance

GCigaVUE-FM v5.8.01 introduced several significant changes that included improvements in
usability and performance. These changes involved upgrading and replacing databases and
changing the underlying operating system. For this reason, when upgrading from any pre-
5.8.xx version of FM to version 5.8.xx or above, you must first migrate your existing
configurations and data such as audit logs, events, syslogs, and statistics from your current
pre-5.8.xx GigaVUE-FM version to GigaVUE-FM v5.10.xx.

Special migration steps and supported upgrade paths are provided under Migrate GigaVUE-
FM in the 510 Documentation. After GigaVUE-FM v5.10.xx, migration is no longer needed
when upgrading to future versions. For supported upgrade paths requiring a special
migration step, see Supported GigaVUE-FM Migration and Upgrade Paths.

Upgrade GigaVUE-FM from the GigaVUE-FM CLI

The following steps describe how to upgrade an existing GigaVUE-FM deployment to the
current release.

1. Verify that only three images are present on the GigaVUE-FM server.

2. Download the new image into GigaVUE-FM using either HTTP, HTTPS, FTP, TFTP, SCP,
or SFTP.

3. Install the new image.
4. Change boot partition.
5. Upgrade GigaVUE-VM (Optional).
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Notes:

It is important to log in with the admin account/username when upgrading the image
on the existing GigaVUE-FM.

After the upgrade completes, rediscover the nodes to recompute node health status.

GigaVUE-FM backup and restore files use a text based format; binary backups or
restore on physical nodes are not supported. For binary backups, you must use the CLI
commands rather than GigaVUE-FM. For more information about the CLI commands,
refer to the GigaVUE-OS CL| Reference Guide.

When using the Firefox or IE browser, clear the cache before upgrading to prevent
issues with the browser.

In your commands use the actual file names of the image(s) you are fetching,
managing, or deploying.

Step 1. Verify that only three images are present on GigaVUE-FM server

NoOTE: It is important that you log in with the admin account/username when
upgrading the image on the existing GigaVUE-FM.

1.

To begin an upgrade, open a SSH session and log into GigaVUE-FM.

2. Check the number of images currently available for installation with the following

command from the GigaVUE-FM CLI:
$ fmctl image list

Important: If there are three images listed in the Images available to be
installed section of the fmctl image list output, Gigamon recommends that
you use the fmctl image delete <Filename> command to remove existing
older images. GigaVUE-FM will display a warning if you attempt to fetch a
fourth image.

3. To delete an existing image from the server use the following command:

$ fmctl image delete <Filename>

4. Go to Step 2: Fetch the latest release of GigaVUE-FM.

Step 2: Fetch the latest release of GigaVUE-FM

Gigamon provides an FTP site where the new release image file resides. To fetch the latest
release, do the following:

1.

Locate the image file for the new release.

2. Copy the image to your file server.

Upgrade GigaVUE-FM 71
Upgrade GigaVUE-FM from the GigaVUE-FM CL



GigaVUE-FM Installation and Upgrade Guide

3. Use the fmctl image fetch commmand to retrieve the software image from your file
server. The CLI shows you the progress of the image fetch with a series of hash marks,
returning you to the system prompt when complete.

NoTE: The image fetch command supports the use of HTTP, HTTPS, FTP, TFTP,
SCP, or SFTP for the transfer of images. The examples are provided to show the
syntax only. In your commmands, use your actual login credentials and the actual
name of the image file you wish to fetch.

a. The following command uses SCP to retrieve the gigamon-gigavue-fm-5.16. image
image from the image server with the IP address of 10.115.0.100 using login and
password.

fmctl image fetch <download URI> [<filename>]
$ fmctl image fetch scp://user:password@10.115.0.100/gigamon-gigavue—-fm-
5.16..img

b. The following command uses FTP to retrieve the same image using login and
password.

$ fmctl image fetch ftp://user:password@10.115.0.100/gigamon-gigavue—-fm-
5.16..img

c. The following command uses TFTP to retrieve the same image without using a
password but using a DNS server instead of an IP address for the download server.

$ fmctl image fetch tftp://myserver.gigamon.com/tftpboot/gigamon-gigavue-fm-
5.16..img

Specify the base directory when using TFTP.

NoOTE: Fetching the image using TFTP is time consuming, due to the size of the
image and the inherent slowness of TFTP. For better performance, use SCP or
HTTP to fetch the image.

4. Go to Step 3: Install the latest release of the GigaVUE-FM.
Step 3: Install the latest release of the GigaVUE-FM

Use the image install command to install the downloaded image file. When running the
following command, the process will first verify that the filename used for the image is
suitable for installation prior to installing the image. For example, to install the image
downloaded in the previous step and provide the location for boot location for installation.

To check current boot location:

$ fmctl image show

This command lists the current boot partition, which can be 1 or 2. Use 2 if the current
partition is 1 and vice e versa.

Sfmctl image install <Filename> <Boot location>
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Step 4. Change the boot partition

Set the image you just installed to boot next with the following command. This ensures that
at the next boot the latest image will be picked up.

$ fmctl image boot next

GigaVUE-FM will reboot with the next boot image and GigaVUE-FM will be upgraded.
Step 5: Upgrade GigaVUE-VM (Optional)

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-VM. Otherwise,
maps Mmay not work and the GigaVUE-VM will be unreachable. For information about
upgrading GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” section in the
GCigaVUE Cloud Suite for VMware—GigaVUE V Series Guide.

Upgrade GigaVUE-FM from the Ul

This section describes the steps to upgrade GigaVUE-FM from the Ul. You can upgrade by
using an image that is located on an external image server, or you can use GigaVUE-FM as
the image server.

Keep in mind the following rules and notes before you upgrade GigaVUE-FM from the Ul:

« When using the GigaVUE-FM Ul to upgrade GigaVUE-FM, you can only upgrade to the
currently available version or to the next version. You cannot downgrade.

* When using the Firefox browser, clear the cache before upgrading to prevent issues with
the browser.

» When upgrading GigaVUE-FM to the latest image file, the upgrade operation will fail if
GigaVUE-FM already has three image files. Delete the unused image files before
proceeding to download a new image file.

NOTE: You can enable auto-purge of GigaVUE-FM images using an API. Contact
Gigamon Technical Support for assistance.

e Starting from software version 5.15.00, subsequent GigaVUE-FM upgrade operation to
higher versions deletes the upgraded GigaVUE-FM image file irrespective of the
completion status. For example, when upgrading from 5.15.00 to 5.16.00, irrespective of
whether the upgrade process fails or succeeds, GigaVUE-FM deletes the 5.16.0.0 image file
at the end of the upgrade process.

Upgrade from External Image Server

This section provides the steps for upgrading the GigaVUE-FM from an image stored on an
external server. The image can be transferred from the server to the GigaVUE-FM using
either SCP or TFTP file protocols.
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To upgrade with an image stored on an external image server, do the following:
1. Upload the image to the external image server to make it available to GigaVUE-FM.

To obtain software images, register on the Gigamon Customer Portal and download
the software.

2. Add the image server to GigaVUE-FM. This stores the credentials, image file name, and
IP address of the server on GigaVUE-FM.

To add the image server:

a. On the left navigation pane, cIick.

b. Select System on the left navigation panel and go to Images > External Servers.
The External Servers page appears.

c. Click Add. The Add External Server page appears.
d. On the Images Server page, specify the following:

An alias to help identify the image server.

The host IP address of the server.

The protocol to use for the download: SCP or TFTP.

The user name and password if you selected SCP. They are not needed for TFTP.

e. Click Save.

The External Server page displays the newly added external server. From the Admin
drop-down list in the top right corner of the window, select Upgrade to open the
FM Image Upgrade page as shown in the following figure.

Software Upgrade
Image File

Select the file server where you have uploaded the image file.

Image Server: MewExternalServer W

; stk , .
Image File Path: {<image path=/<image name:

To monitor the progress and status of the upgrade, click “GigaVUE Administration
Guide”.
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3. Onthe FM Image Upgrade page, click on the Image Server field and select the server
added in Step 2.

4. In the Image File Path, enter the image path and filename on the external file server.
5. Upgrade any deployed GigaVUE-FM-VMs,

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-FM-VMs,
Otherwise, maps may not work and the GigaVUE-FM-VMs will be unreachable. For
information about upgrading GigaVUE-FM-VM, refer to the “Bulk Upgrading GigaVUE-
VM Nodes” section in the GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide.

Upgrade with GigaVUE-FM as the Image Server

This section provides the steps for upgrading GigaVUE-FM when GigaVUE-FM is used as the
file server instead of an external server.

Upgrading from GigaVUE-FM 5.6.01 to 5.7.xx.00 or 5.7.01 via an internal image will not work
because internal server storage does not function during the upgrade procedure.
Alternatively, you can upgrade using an external image server or the GigaVUE-FM CLI or you
can use the GigaVUE-FM internal storage to store the GigaVUE-FM image, and point to it as
if it were an external server as follows:

1. Add the GigaVUE-FM 5.7 image under the GigaVUE-FM internal image server
(/config/gigamon/imagesRepo).

2. Configure the GigaVUE-FM external server with the GigaVUE-FM IP address.

3. Initiate the upgrade process, select External Image Server, and then specify the path to
the GigaVUE-FM Image file that you added in step 1
(/config/gigamon/imagesRepo/fma5700.img).

To upgrade a GigaVUE-FM using internal image files, do the following:

1. Download the images from the Gigamon website and place them where they can be
available for uploading to GigaVUE-FM.

To obtain software images, register on the Gigamon Customer Portal and download
the software.

2. Upload the images file to GigaVUE-FM.

a. On the left navigation pane, cIick and select to System > Images > Internal
Image Files.

b. On the Internal Image File page, click Upload.
c. Click Browse to locate the image file.

d. Click OK to upload the file. The page displays the progress of the upload.

After the upload completes, you can see the GigaVUE-FM image to use for the
upgrade on the Internal Images Files page.
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3. Click the Admin drop-down list on the top right of the window and select Upgrade.

4. Onthe FM Image Upgrade page, click in the Image Server field and select Internal
Image Server.

Software Upgrade

Image File

Select the file server where you have uploaded the image file.

Image Server: Internal Image Server v

Version: |

Image File:

5. From the Version drop-down list, select the version to which you are upgrading.

NOTE: You can only upgrade to another instance of the current version or the
immediate next version. Downgrading to a lower version is not supported
through the Ul.

6. Click Upgrade.

NoTE: When you change the IP address of the GigaVUE-FM instance using the
jump-start configuration, the internal database and the in-memory caches of
the GigaVUE-FM instance are not updated. The Database continues to have the
IP address of the old GigaVUE-FM, and the image upgrade using the internal

server option does not work. To fix this, you must restart the GigaVUE-FM
instance after upgrade.

On the left navigation pane, cIick , to monitor the progress and status of the
upgrade and select Events on the left navigation pane. Also, email notifications are
sent if email notifications have been configured.

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-FM-VMs,
Otherwise, maps may not work and the GigaVUE-FM-VMs will be unreachable. For
information about upgrading GigaVUE-FM, refer to the “Bulk Upgrading GigaVUE-VM
Nodes” section in the GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide.
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NoTE: If you are using FireFox, clear the cache before upgrading to prevent issues
with the browser.

How to Use the Snapshot Feature

Follow the steps below to upgrade to the current release version of GigaVUE-FM using the
snapshot feature.

E A note about upgrading from very old versions of GigaVUE-FM:

« This procedure is only valid for upgrading from GigaVUE-FM v3.0 and above. For
upgrades from pre-3.0 releases, review the GigaVUE-FM v3.0 User's Guide and
upgrade to release GigaVUE-FM v3.1.

» You cannot directly upgrade from a pre-3.3 releases to the current release. You
can only upgrade from GigaVUE-FM v3.3 or v3.4 release.

1. Prior to upgrading, ensure that the available memory size is at least 8GB prior to
upgrading to the new GigaVUE-FM release. If the available memory size is less than
8GB, it will cause out of memory issues. Also, at least 2 vCPU are required.

2. When upgrading from v3., it's a good idea to use the vSphere client's Snapshot
feature to record the current state of the GigaVUE-FM virtual machine. Steps to use
Snapshot feature are as follows:

a. Log into the vSphere client and navigate to the Datacenter or Cluster level where
the GigaVUE-FM installation is located.

b. Right-click the GigaVUE-FM entry in the vSphere client and select the Take
Snapshot option.

Upgrade GigaVUE-FM
How to Use the Snapshot Feature

77



GigaVUE-FM Installation and Upgrade Guide

4 wCEA ™ X [ GigaVUEFM22  Actions ~ =
m' E‘D Actions - GigaWVUE-FM22 jetting Started | Summary Monitor Manage Related Objects
Q
B [ Poweron Whatis a Virtual Machine?
1 Shut Down Guest 08 Avirtual machine is a software computer that,
@ Restart Guest 0S like a physical computer, runs an operating
) system and applications. An operating < Virtual Machines
& Migrate... system installed on a virtual machine is | &
Take Snapshot. . called a guest operating system. ‘3\
iy Revertto Latest Snapshot Because every virtual machine is an isolated Chister
;(ﬁ IManage Snapshots.. computing environment, you can use virtual
. ’ machines as desktop or workstation
g® Clone to Virtual Machine environments, as testing environments, or to
55 Clone to Template... consolidate server applications Host
{5 Edit Setfings... InvCenter Server, virual machines run on
hosts or clusters. The same host can run
Move To.. many virtual machines. . -
Datacenter
Rename... vCenter Server
4 AssionTag... vSphere Client
G Remave Tag
Alarms »
Al vCenter Actions * | Basic Tasks Explore Further
1 ) . .
[» Power on the virtual machine Learn how to install a guest
W Power off the virtual machine operating system
10 Suspend the virtual machine Learn more about virtual machines
|I G Edit virtual machine settings Learn about templates
M W ” N N
Figure1 “Take Snapshot” Command to Preserve Current Settings Prior to Upgrade
M 1
c. Follow the system prompts to record a snapshot of GigaVUE-FM's current state.
4 venter Servers »| ¥ X | [ZvCSA | Actions +
Getting Started  Summary  Monitor  Manage | Related Objects |
7 Top Level Objects
Datacenters [ 1 |Top Level Objects | Datacenters | Clusters | Hosts |Virtua| Machines ‘VM Templates |w\pps | Datastores | Datastore Clusters | Standard Metwor = »
T clusters | B B 1o | Shactions v [E [a Filter -
Host:
@ Hosts Name 14 State Status Provisioned Space Used Space Hest CPU Host Mem Gus
G Virtual Machines ) — S
U Templates E‘B GigaVUE-FM21 ineredD[ &1 Actions - GigaVUE-FM21 i 6.28 GB 0 MHz ome
- G GigaVUE-FM22 Powered Or 3 15.3 GB 0 MHz 0OMB
& vpps G, vHD-51 Powered OF 3.8 GB 0 MHz oMB
B patastores & vHD4-50 Powered Of = Shut Down Guest OS 331 GB 0 MHz 0B
& Datastore Clusters G VMware vCenter Server Appliance Powered Of Y Restart Guest 05 3 15.09 GB 0 MHz 0MB
Q Standard Networks 5 Migrate...
&= Distributed Switches fiy Take Snapshot...
22 Distributed Port Groups
& Extensions fiz» Manage Snapshots..
&5 Clone to Virtual Machine...
g7 Clone to Template...
5 Edit Settings...
Move To...
Rename... | Power 3
{3 Remaove Tag Snapshots » [ Suspend
Alarms v| & Migrate.. & Reset
All vCenter Actions 1 28 Clone to Virtual Machine... Shut Down Guest 08
5‘3 Clone to Template... @ Restart Guest 0S8
| 4
Figure 2 Power Off Command
Upgrade GigaVUE-FM 78

How to Use the Snapshot Feature



GigaVUE-FM Installation and Upgrade Guide

Upgrade GigaVUE-FM Iin Azure

This chapter describes how to upgrade the GigaVUE-FM instance on Azure.

Refer to the following sections for details:
« AtaGlance
» Stop GigaVUE FM Instance
« Create Snapshot of the GigaVUE-FM Instance
«» Upgrade GigaVUE-FM Instance

Upgrade GigaVUE-FM in Azure
How to Use the Snapshot Feature
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Upgrade GigaVUE-FM in AWS

This chapter describes how to upgrade the GigaVUE-FM instance on AWS.

Refer to the following sections for details:

= AtaGlance

« Stop GigaVUE-FM FM Instance

« Create Snapshot of the GigaVUE-FM Instance
« Upgrade GigaVUE-FM Instance

At a Glance

To upgrade the GigaVUE-FM instance successfully, you must perform the following steps:
Step 1. Stop the existing version of the GigaVUE-FM instance.

Step 2: Create a snapshot of the second disk (dev/sdb) of the FM instance.

Step 3: Make a note of the snapshot ID.

Step 4: Launch the latest version of the GigaVUE-FM instance. While launching the latest
version, enter the snapshot ID of the old version of the GigaVUE-FM instance in Add Storage
> Add New Volume.

Step 5: Complete the launch.

Step 6: Verify if the data from the previous GigaVUE-FM instance is restored in the new
instance.

Step 7: Terminate the old FM instance.

Stop GigaVUE-FM FM Instance

Before upgrading the GigaVUE-FM instance, the existing version of the GigaVUE-FM
instance must be stopped.

NoTE: Do not terminate the GigaVUE-FM instance.

To stop the GigaVUE-FM instance:
1. Login to the AWS account and select Services > EC2.

2. Inthe left navigation pane, select Instances.
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3.

In the search field, enter the name of the existing GigaVUE-FM instance and select the
Instance ID.

NoTE: If the instance ID is the password for logging in to the existing GigaVUE-FM,
make note of this instance ID. This instance ID will be used as the password for
logging in to the upgraded GigaVUE-FM as well. If the password is changed, use the
changed password to login to the upgraded GigaVUE-FM.

4.

Go to Actions > Instance State > Stop.

Create Snapshot of the GigaVUE-FM Instance

You must create a snapshot of the volume of the existing version (dev/sdb) of the
GigaVUE-FM instance. Snapshots capture data that are written to your Amazon EBS volume
at the time the snapshot is taken. This excludes any data that are cached by any applications
or the operating system.

To create a snapshot:

1.

2.
3.

©.

Select the GigaVUE-FM instance and click the Description tab.
Scroll down and locate Block Devices.

Click the /dev/sdb link. The Block Device dialog box is displayed with the volume 1D
link.

In the Block Device dialog box, click the volume ID link. The Volumes page is displayed.
Click Actions and select Create Snapshot.
The Create Snapshot dialog box is displayed.

In the Create Snapshot dialog box, enter the following information:

Table 1: Fields for Creating a Snapshot

Field Description

Name The name of the snapshot.
Description The description of the snapshot.
7. Click Create. It will take several minutes for the snapshot to be created.

NOTE: Make a note of the snapshot ID. This snapshot ID will be used to find the
snapshot and add the volume while upgrading the GigaVUE-FM instance.

Upgrade GigaVUE-FM in AWS 8]
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Upgrade GigaVUE-FM Instance

While upgrading the GigaVUE-FM instance, the Amazon EBS volume must be restored with
the data from the snapshot that is created in Create Snapshot of the GigaVUE-FM Instance.
To upgrade the GigaVUE-FM instance:

1. Select Services > EC2.

2. Click Launch Instance and go to AWS Marketplace or Community AMils.

3. Search for Gigamon, locate the latest version of the GigaVUE-FM AMI, and click Select.

4. Choose the Instance Type. The recommended instance type is mé4.xlarge.

NoTE: Do not select the t2 instance types as they are not supported.

Click Next: Configure Instance Details.
6. Enter the following information.

o Network— Select the VPC where you want to launch the AMI.

o Subnet— Select the management subnet that the instance will use after launch.
(Required)

o Auto-assign Public IP— Select Enable.

o lAM role—Select an existing IAM role to associate with the instance. Refer to the
GigaVUE Cloud Suite for AWS Quick Start Guide.

Click Next: Add Storage and click Add New Volume.
8. Enter the following storage device settings:
o Snapshot—Enter the name of the snapshot that is created in step 9 in the section

Create Snapshot of the GigaVUE-FM Instance.

o Size (GiB)— Enter a minimum of 40Gb of storage. The size of the volume must be
same as the volume selected while launching the previous version of the GigaVUE-
FM instance.

o Volume Type— Select a volume type. The recommended volume is General
Purpose SSD (GP2).

o Delete on Termination— Select this check box to make sure the volumes are
cleaned up when the GigaVUE-FM instance is removed.
9. Click Next: Tag Instance, and then add a key-value pair to identify the instance.

10. Click Next: Add Security Group. Click the Select an existing security group check
box if the security group is already created. Otherwise, select the Create a new
security group check box and click Add Rule. For more information on creating a
security group, refer to the GigaVUE Cloud Suite for AWS-GigaVUE V Series 2

1. Click Review and Launch. Review the instance launch details and click Launch.
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12. Select the SSH key pair, check the acknowledgment check box, and click Launch
Instances.

13. It will take several minutes for the instance to initialize. After the initialization is
completed, verify the instance through the Web interface as follows:

a. Find the instance and expand the page in the Descriptions tab to view the instance
information, if necessary.

b. Copy the Public DNS value and paste the value into a new browser window or tab.

c. Copy the Instance ID of the previous version of the GigaVUE-FM. If the password is
changed, use the changed password to login to the upgraded GigaVUE-FM.

NoTE: Do not have multiple versions of GigaVUE-FM instances monitoring the same
AWS connection.

Launch the new version of the GigaVUE-FM instance. Verify if the data from the previous
GigaVUE-FM instance is restored in the new instance. Once the data is verified, terminate
the old version of the GigaVUE-FM instance.

Post Installation Configurations

Refer to the following sections for details:

¢ |nstall Custom Certificate
o |nstall Rabbit MQ Certificate
e Communication between GigaVUE-FM Load Balancer and Web Server

Install Custom Certificate

To install a third-party certificate on GigaVUE-FM, refer to the following sections:

e Pre-requisites
e Steps

Pre-requisites

Refer to the following pre-requisites:
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» Take a backup of the default system self-signed certificate and key contents before
replacing them with third-party certificate and key. The files are available in the following
folders:

e localhost.crt: /etc/pki/tls/certs/localhost.crt
e localhost.key: /etc/pki/tls/private/localhost.key
* When replacing the certificate key and file ensure to adhere to the following naming
convention:
o For Certificate: localhost.crt
o For Certificate Key: localhost.key
* When you copy the contents of the certificate file, do not delete the EOL characters at the
end of each line. If there is no EOL character at the end of certificate file, insert one.

e |n case of chain of certificates, bundle the server, intermediate, and root certificates into a
single certificate file before replacing the localhost.crt.

e For chain of certificates, add the SSLCertificateChainFile directive to
/etc/httpd/conf.d/ssl.conf: sudo vim /etc/httpd/conf.d/ssl.conf. Add the following
line:ssLCertificateChainFile /etc/pki/tls/certs/localhost.crt.

Steps

Generate the certificate and a private key file in pem format. Use the following command on
Linux or a Linux app (such as Cygwin) for generating the files:

openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout privatekey.pem -out
certificate.pem

Copy the contents of the certificate file.

To install the certificates:
1. Login tothe GigaVUE-FM CLI.
2. Execute the following steps from the shell prompt as a root user (sudo):

o Replace SSLCertificateFile: /ete/pki/tls/certs/localhost.crt

o Replace SSLCertificateKeyFile: /etc/pki/tls/private/localhost.key

o Provide access to certificate: chmod 644

o Provide access to key: chmod 600

o Configure GigaVUE-FM load balancer functionality:
cat /etc/pki/tls/certs/localhost.crt
/etc/pki/tls/private/localhost.key > /etc/pki/tls/certs/localhost.pem

systemctl reload haproxy.service

o Restart apache as root: systemctl restart httpd.service

o After restarting, ensure tomcat is up and running: sudo systemctl status
tomcat@cms. service
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The system will now start using the newly installed certificate.

GigaVUE-FM uses a public key (cms.pl2 file) to encrypt the Security Assertion Markup
Language (SAML) messages. You can either use the default public key available in
GigaVUE-FM or generate a new public key using the following command:

sudo openssl pkcsl2 -export -name CMS -out /etc/gigamon/cms.pl2 -inkey
/etc/pki/tls/private/localhost.key -in /etc/pki/tls/certs/localhost.crt -
passout pass:cmsl23

You will be prompted for a pass phrase for the localhost.crt.

After the public key (cms.pl12 file) is generated, place the file in the retcigigamon directory.
Change the access rights to chmod 644.

Install Rabbit MQ Certificate

To update the Rabbit MQ certificate, generate the certificate and a private key file in pem
format. Use the following command on Linux or a Linux app (such as Cygwin) for generating
the files:

openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout privatekey.pem -out
certificate.pem

Copy the contents of the certificate file.

To update the RabbitMQ files:

1. Log in to the GigaVUE-FM CLI.
2. Execute the following steps from the shell prompt as a root user (sudo):

Replace the existing certificate: /var/lib/gigamon/rabbitmq/server/cert.pem
Example: cp certificate.pem /var/lib/gigamon/rabbitmq/server/cert.pem
Replace the existing private key: /var/1ib/gigamon/rabbitmq/server/key.pem
Example: cp privatekey.pem /var/lib/gigamon/rabbitmqg/server/key.pem

Provide access to certificate and key: chmod 644

NOTE: It is not required to reload the RMQ service.
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Communication between GigaVUE-FM Load
Balancer and Web Server

After GigaVUE-FM is installed, communication is established between GigaVUE-FM Load
Balancer (HA-proxy service) and the apache web server. If IPv6 (global, link-local, loopback) is
disabled in all the network interfaces, then GigaVUE-FM GUI may not be accessible. Use the
following command to access the GigaVUE-FM GUI:

curl -XPOST "http://localhost:4466/fmcs/configureloadBalancer?pretty"”" -H
"Content-Type: application/json" -d '{"enable ipvé" : "true"}'

The reason for inaccessibility of GigaVUE-FM GUI is as follows: by default, Load Balancer uses
the IPv6 loopback address to communicate with the webserver present locally. If IPv6
address is not present in the system, the webserver cannot listen/accept any
communication through IPv6 address and therefore rejects the request.

This behavior is observed only from software version GigaVUE-FM >= 513.00 and may be
noticed after installation/upgrade of GigaVUE-FM, and also any time when GigaVUE-FM is
up and running.

NoTE: Use the following command to change from IPv6 to IPv4 loopback address:
curl -XPOST "http://localhost:4466/fmcs/configureLoadBalancer?pretty" -H "Content-
Type: application/json" -d '{"enable_ipv6" : "false"}'

Reference

This section provides additional information useful for GigaVUE-FM installation and upgrade.

Topics:
« Setting the GigaVUE-FM Admin Password
« GigaVUE-FM CLI Commands

Setting the GigaVUE-FM Admin Password

You can set the admin password for GigaVUE-FM from the GigaVUE-FM Command-line
Interface (CLI) or from the GigaVUE-FM GUI. This topic describes the requirements for the
password.

The characters in the admin password must include, at least:

e One numerical character
» One upper case character
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¢ One lower case character
* One special character

If the password does not meet the complexity requirements:

» The system does not display any error message.

» The parameters configured above are not passed on to the GigaVUE-FM except the host
name parameter.

» The static IP addresses that were configured originally will be unavailable after GigaVUE-
FM is deployed.

Setting the Admin Password from the GigaVUE-FM CLI

You must change the default admin password when you first login to the GigaVUE-FM CLI.
The password can be a minimum of 14 characters and a maximum of 255 characters, and
must comply with the character requirements specified above.

NoTE: The password that you set from the GigaVUE-FM CLI is applicable only to the
GigaVUE-FM CLI.

Setting the Admin Password from the GigaVUE-FM GUI

The default username and password for a admin user in GigaVUE-FM GUI is admin and
admini23A!l, respectively. If GigaVUE-FM is deployed inside AWS or OpenStack, then the
default password is the Instance ID.You can change the default admin password from GUI.
The password can be a minimum of 8 characters and a maximum of 64 characters, and
must comply with the character requirements specified above.

NOTE: The password that you set from the GigaVUE-FM GUI is applicable only to the
GigaVUE-FM GUIL.

CigaVUE-FM CLI Commands

This section describes the commands for the GigaVUE-FM Command-Line Interface (CLI)
related to installation and upgrade processes.

fmctl

Use the fmctl command to manage GigaVUE-FM-related configurations.

The fmctl command has the following syntax:

fmctl
configuration [backup]|restore][<absolute pathname of backup file>]

Reference 87

GigaVUE-FM CLI Commands



GigaVUE-FM Installation and Upgrade Guide

image

fetch <download URI> [<filename>]

list [details] [<filename>]

install <filename> [next|location {1]|2}]

boot [next|location {1]|2}]

delete [force] <filename>

{move|rename} <old filename> <new filename>

show

jump-start

logging [<fqdn>[:<port>]] [facility <facility>] [priority <priority>] [udp]|tcp]
no logging <fqdn>[:<port>]

reset factory halt

set Ul admin password <new password>

{get|show} interface [[mgmt|management}]
set interface {mgmt|management} <interface name>
[options{--help]|--interface <interface name>}]
set mapping <fqdn> <IP address>
{get|show} {ip|ntp|hostname|domain|fqdn}
set [ip|ip6] dhcp
set [ip|ip6] [static] <address/cidr> <gateway> <dns1>[,<dns2>[,...]
set {ip|ip6} route {add|remove} address/cidr gateway
set ntp {disable|[enable] <serverl>[,<server2>|[,...]}
set hosthame <hostname>
set domain <domain>
set fqdn <hostname> <domain>
set/get/show searchdomains [<domain1>[,<domain2>[,...]]]
set/get/show nameservers [<dns1>[,<dns2>[,...]]]
show backup [<absolute pathname of backup file>]

The following table describes the arguments for the fmetl command:
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Argument Description

configuration [backup|restore]

Backs up and restores the configurations such as
management interface, hostname, domain, IP, search
domains, and NTP.

For example, use the following command to back up
the system configurations:

fmctl configuration backup <absolute
path name of backup file>

Use the following commmand to restore the system
configurations from the backup:

fmctl configuration restore <absolute
path name of backup file>

image fetch <download URI>
[<filename>]

Retrieves a saved configuration file from a remote
host. Use HTTP(S), FTP, TFTP, or SCP to retrieve the file.
The format for the download URL is as follows:

[protocol]://username
[:password]@hostname/path/filename

For example, the following command retrieves the
configuration file named myconfig from the FTP
server at 192.168.1.10 using the robh account with the
xray password:

fmctl image fetch
ftp://robh:xray@192.168.1.10/myconfig

You can also use the <filename> argument to give the
retrieved file a new name on the GigaVUE-FM H Series
node. For example, the following commmand retrieves
myconfig and names it newconfig on the node:

fmctl image fetch
scp://bbochy:catch1@192.168.1.75/myconfig
newconfig

NoOTE: You cannot retrieve a file with the same
name as the currently active configuration file.

image list

Provides the list of image file names available in
GigaVUE-FM.
For example:

fmctl image list

image install <filename>
[next|location {1|2}]

Installs the image file.

For example, use the following command to install
the image file on the next partition:

fmctl image install gigamon-gigavue-
fm-5.8.00-160194%-trial.img next

Use the following commmand to install the image file
on the specified partition:

fmctl image install gigamon-gigavue-
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Argument Description

fm-5.8.00-160194-trial.img location 1

NOTE: Ensure that your current partition is not the
same as the partition you specified for installation.
Else, an error is displayed.

image boot [next|location {1]2}]

Boots the image file on the specified partition. Ensure
that the partition has the installed image file.

For example, use the following command to boot the
image file on the next partition:

fmctl image boot next

Use the folloaing command to boot the image file on
the specified partition:

fmctl image boot location 1

NoTE: GigaVUE-FM reboots immediately.

image delete [force] <filename>

Deletes the named image file.
For example:
fmctl image delete myimage

image {move|rename} <old
filename> <new filename>

Moves or renames the specified image file. For
example, the following command renames myimage
as newimage:

fmctl image rename myimage newimage

image show

Displays the last boot partition.
For example:
fmctl image show

jump-start

Runs the configuration wizard for the initial setup of
GigaVUE-FM. Refer to Perform Initial Configuration.

NoTe: When you change the IP address of the
GigaVUE-FM instance using the jump-start
configuration, the internal database and the in-
memory caches of the GigaVUE-FM instance are not
updated. The Database continues to have the IP
address of the old GigaVUE-FM, and the image
upgrade using the internal server option does not
work. To fix this, you must restart the GigaVUE-FM
instance after upgrade.

logging [<fqdn>[:<port>]] [facility
<facility>] [priority <priority>]
[udp]tcp]

Configures the logging server.
For example:

fmctl logging 1.2.3.4:9514 facility *
priority debug tcp

no logging <fqdn>[:<port>]

Removes the logging server configuration.
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Argument Description

For example:
fmctl no logging 1.2.3.4:9514

reset factory halt

Resets the GigaVUE-FM instance to the default
configuration and shuts down the system.

For example:
fmctl reset factory halt

set Ul admin password <new
password>

Configures a new admin password for the GigaVUE-
FM Ul only.

For information on setting the GigaVUE-FM password,
refer to Setting the GigaVUE-FM Admin Password .

{get|show} interface
[{mgmtmanagement}]

Displays the management interface configured for
the GigaVUE-FMinstance.

For example:
fmctl get|show interface management

set interface {mgmt|management}
<interface name>

Configures the management interface for the
GigaVUE-FM instance, which has more than one
ethernet interface.

For example:
fmctl set interface management ethl

NOTE: You cannot use the --interface syntax with
the set interface management argument.

--interface <interface name>

Allows various configurations that can be set for the
management interface. This is an optional argument.

For example, use the following command to ensure
that ethl management interface uses DHCP:

fmctl --interface ethl set ip dhcp

[options{--help]|--interface
<interface name>}] set mapping
<fqdn> <IP address>

Maps the FQDN with the IP address of GigaVUE-FM.
For example:

fmctl --interface eth1 set mapping fm
10.10.10.1

Use the following command to remove the mapping:
fmctl --interface eth1 set mapping fm

[options{--help]|--interface
<interface name>}] {get|show}
{ip|ntp|hostname|domain|fqdn}

Use to either fetch or display the IP address, NTP
configurations, host name, domain name, or FQDN .

For example:

fmctl --interface ethl get
{ip|ntp|hostname|domain|fqdn}
fmctl --help show
{ip|ntp|hostname|domain|fqdn}

[options{--help]|--interface
<interface name>}] set [ip|ip6]

Configures the management interface to use DHCP.

For example:
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Argument Description

dhcp fmctl --interface ethl set ip dhcp
[options{--help]|--interface Configures the static IP address and gateway on the
<interface name>}] set [ip|ip6] management interface. You can also choose to
[static] <address/cidr> <gateway> | configure DNS.

<dnsl1>[,<dns2>[,...] For example:

fmctl --interface ethl set ip static
10.115.46.72/21 10.115.40.1 10.10.1.20

[options{--help]|--interface Adds or removes the IP address and gateway for the
<interface name>}] set {ip|ip6} management interface.

route {add|remove} address/cidr

gateway

[options{--help]|--interface Use to enable or disable NTP for synchronization of
<interface name>}] set ntp the system's clock.

{disable|[enable] <serverl> For example, the following commmand disables NTP:

<server2>|,... . .
L -1} fmctl --interface ethl set ntp disable

You choose to enable NTP and add NTP servers. For
example, the following command enables NTP and
adds a NTP server:

fmctl --interface ethl set ntp enable

192.168.1.10
[options{--help]|--interface Configures the hostname.
<interface name>}] set hostname For example:
< >
hostname fmctl --interface eth1 set hostname
myfm
NOTE: Ensure that you log out and re-login to the
GigaVUE-FM to view the changes.
[options{--help]|--interface Configures the domain for GigaVUE-FM.
<interface name>}] set domain For example:
< in>
domain fmctl --interface eth1 set domain
gigamon.com
[options{--help]|--interface Configures the Fully Qualified Domain Name (FQDN)
<interface name>}] set fqdn for the current GigaVUE-FM.
<hostname> <domain> fmctl --interface ethl set fqdn myfm
gigamon.com
Reference
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Argument Description

[options{--help]|--interface
<interface name>}] set/get/show
searchdomains [<domainl>
[,<domain2>[,...]1]1

Displays a list of domains for the current GigaVUE-FM
For example:
fmctl --interface ethl set searchdomains
fmctl --help get | show searchdomains

[options{--help]|--interface
<interface name>}] set/get/show
nameservers [<dns1>[,<dns2>[,...]]1]

Displays a list of name servers for the current
GigaVUE-FM

For example:
fmctl --interface eth1 set nameservers
fmctl --help get | show nameservers

[options{--help]|--interface
<interface name>}] show backup

Displays the configurations that were backed up.
For example:

fmctl --help show backup <absolute
path name of backup file>

fmctl set Ul admin password 'admin!!"

NoTE: To include special characters in the £met1 command line, enclose the string
containing the special characters within single quotes. For example, to include the
bang (!) special character in a password string, you must enclose the password string
within single quotes, as shown in the following example:

Reference
GigaVUE-FM CLI Commands
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Additional Sources of Information

This appendix provides additional sources of information. Refer to the following sections for
details:

« Documentation

= Documentation Feedback

« Contact Technical Support

« Contact Sales

« The Gigamon Community

Documentation

This table lists all the guides provided for GigaVUE-FM software and hardware. The first row
provides an All-Documents Zip file that contains all the guides in the set for the release.

NoTE: In the online documentation, view What's New to access quick links to topics
for each of the new features in this Release; view Documentation Downloads to
download all PDFs.

Table 1: Documentation Set for Gigamon Products

GigaVUE-FM 5.16. Hardware and Software Guides

DID YOou KNOW? [f you keep all PDFs for a release in commmon folder, you can easily search across the doc set
by opening one of the files in Acrobat and choosing Edit > Advanced Search from the menu. This opens an
interface that allows you to select a directory and search across all PDFs in a folder.

Hardware

how to unpack, assemble, rack-mount, connect, and initially configure ports the respective GigaVUE-FM
devices; reference information and specifications for the respective GigaVUE-FM devices

G-TAP A Series 2 Installation Guide

GigaVUE-HC1 Hardware Installation Guide

GigaVUE-HC2 Hardware Installation Guide

GigaVUE-HC3 Hardware Installation Guide

GigaVUE M Series Hardware Installation Guide

GigaVUE TA Series Hardware Installation Guide

GigaVUE-FM Hardware Appliance Guide for GFM-HW1-FMO10

GigaVUE-OS Installation Guide for DELL S4112F-ON
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GigaVUE-FM 5.16. Hardware and Software Guides

Software Installation and Upgrade Guides

GigaVUE-FM Installation, Migration, and Upgrade Guide

GigaVUE-OS Upgrade Guide

Administration

GigaVUE Administration Guide
covers both GigaVUE-OS and GigaVUE-FM

Fabric Management

GigaVUE Fabric Management Guide

how to install, deploy, and operate GigaVUE-FM; how to configure GigaSMART operations; covers both
GigaVUE-FM and GigaVUE-OS features

Cloud Configuration and Monitoring

how to configure the GigaVUE Cloud Suite components and set up traffic monitoring sessions for the cloud
platforms

GigaVUE V Series Quick Start Guide

GigaVUE Cloud Suite for AWS-GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for AWS-GigaVUE V Series 1 Guide

GigaVUE Cloud Suite for Azure-GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for Azure-GigaVUE V Series 1 Guide

GigaVUE Cloud Suite for OpenStack-GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for OpenStack-GigaVUE V Series 1 Guide

Gigamon Containerized Broker Guide

GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide

GigaVUE Cloud Suite for AnyCloud Guide

GigaVUE Cloud Suite for Kubernetes Guide

GigaVUE Cloud Suite for Nutanix Guide

GigaVUE Cloud Suite for VMware—GigaVUE-VM Guide

GigaVUE Cloud Suite for AWS Secret Regions Guide

Reference

GigaVUE-OS CLI Reference Guide
library of GigaVUE-OS CLI (Command Line Interface) commmands used to configure and operate GigaVUE
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GigaVUE-FM 5.16. Hardware and Software Guides

H Series and TA Series devices

GigaVUE-OS Cabling Quick Reference Guide
guidelines for the different types of cables used to connect Gigamon devices

GigaVUE-OS Compatibility and Interoperability Matrix
compatibility information and interoperability requirements for Gigamon devices

GigaVUE-FM REST API Reference in GigaVUE-FM User's Guide
samples uses of the GigaVUE-FM Application Program Interfaces (APIs)

Release Notes

GigaVUE-OS, GigaVUE-FM, GigaVUE-VM, G-TAP A Series, and GigaVUE Cloud Suite Release Notes
new features, resolved issues, and known issues in this release ;
important notes regarding installing and upgrading to this release

NoTE: Release Notes are not included in the online documentation.

NoTE: Registered Customers can log in to My Gigamon to download the Software and Release Notes
from the Software & Docs page on to My Gigamon. Refer to How to Download Software and Release
Notes from My Gigamon.

In-Product Help

GigaVUE-FM Online Help
how to install, deploy, and operate GigaVUE-FM.

GigaVUE-OS H-VUE Online Help
provides links the online documentation.

How to Download Software and Release Notes from My Gigamon

Registered Customers can download software and corresponding Release Notes documents
from the Software & Release Notes page on to My Gigamon. Use the My Gigamon Software
& Docs page to download:

* Gigamon Software installation and upgrade images,
* Release Notes for Gigamon Software, or
e Older versions of PDFs (pre-v5.7).
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To download release-specific software, release notes, or older PDFs:

1. Log in to My Gigamon
2. Click on the Software & Release Notes link.

3. Use the Product and Release filters to find documentation for the current release. For
example, select Product: "GigaVUE-FM" and Release: "5.6," enter "pdf" in the search box,

and then click GO to view all PDF documentation for GigaVUE-FM 5.6.xx.

NoTeE: My Gigamon is available to registered customers only. Newer documentation
PDFs, with the exception of release notes, are all available through the publicly
available online documentation.

Documentation Feedback

We are continuously improving our documentation to make it more accessible while
mMaintaining accuracy and ease of use. Your feedback helps us to improve. To provide
feedback and report issues in our documentation, send an email to:
documentationfeedback@gigamon.com

Please provide the following information in the email to help us identify and resolve the
issue. Copy and paste this form into your email, complete it as able, and send. We will
respond as soon as possible.

Documentation Feedback Form

Your Name

About You Your Role

Your Company

Online doc link (URL for where the issue is)

For Online Topics

(if it's a long topic, please provide the heading of the

Topic Heading - i -
section where the issue is)

Additional Sources of Information
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Document Title

(shown on the cover page or in page header )

Product Version

(shown on the cover page)

For PDF Topics Document Version

(shown on the cover page)

Chapter Heading

(shown in footer)

PDF page #

(shown in footer)

Describe the issue

Describe the error or issue in the documentation.

(If it helps, attach an image to show the issue.)

How can we improve
the content?

How can we
improve?

Be as specific as
possible.

Any other
comments?

Contact Technical Support

For information about Technical Support: Go to Settings > Support > Contact Support

in GigaVUE-FM.

You can also refer to https://www.gigamon.com/support-and-services/contact-support for

Technical Support hours and contact information.

Email Technical Support at support@gigamon.com.

Contact Sales

Use the following information to Gigamon channel partner or Gigamon sales

representatives.

Telephone: +1.408.831.4025

Additional Sources of Information
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Sales: inside.sales@gigamon.com

Partners: www.gigamon.com/partners.html
Premium Support

Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 Premium
Support. Premium Support entitles you to round-the-clock phone support with a dedicated
Support Engineer every day of the week.

The Gigamon Community

The Gigamon Community is a technical site where Gigamon users, partners, security and
network professionals and Gigamon employees come together to share knowledge and
expertise, ask questions, build their network and learn about best practices for Gigamon
products.

Visit the Gigamon Community site to:

« Find knowledge base articles and documentation
« Ask and answer questions and learn best practices from other members.

« Join special-interest groups to have focused collaboration around a technology, use-
case, vertical market or beta release

« Take online learning lessons and tutorials to broaden your knowledge of Gigamon
products.

« Submit and vote on feature enhancements and share product feedback. (Customers
only)

« Open support tickets (Customers only)
« Download the latest product updates and documentation (Customers only)

The Gigamon Community is a great way to get answers fast, learn from experts and
collaborate directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community@gigamon.com.
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Glossary

D
decrypt list
need to decrypt (formerly blacklist)
decryptlist
need to decrypt - CLI Command (formerly blacklist)
drop list
selective forwarding - drop (formerly blacklist)
F

forward list

selective forwarding - forward (formerly whitelist)

L
leader

leader in clustering node relationship (formerly master)
M

member node

follower in clustering node relationship (formerly slave or non-master)

N

no-decrypt list

no need to decrypt (formerly whitelist)
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nodecryptlist

no need to decrypt- CLI Command (formerly whitelist)

P

primary source

root timing; transmits sync info to clocks in its network segment (formerly grandmaster)

R

receiver

follower in a bidirectional clock relationship (formerly slave)

S

source

leader in a bidirectional clock relationship (formerly master)
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